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ﬁ' What is FotoMagico?

FotoMagico is an application for creating and presenting live multimedia slideshows. The primary goal
is to present your pictures with the best possible image quality that your display device offers. Typical
display devices are your computer's screen, a TV set, or projector.

Aside from high image quality, the focus lies on easy and powerful authoring of your presentation.
FotoMagico provides a simple, yet elegant and intuitive user interface. Using FotoMagico, you can:

= Create stunning slideshow presentations.
= Use photos from an iPhoto, Aperture, or Adobe Lightroom library or any folder on a local drive.
= Zoom, move, and rotate the images to highlight the most important areas of your photos.

= Animate your photos using 'Pan & Zoom'. This type of animation is also known as the Ken Burns
effect.

= Add video to your slideshow. All file formats that can be read and played by QuickTime are
supported by FotoMagico.

= Add titles to your slideshow to create a compelling narrative.

= Use music and sound effects from your iTunes library to create an appropriate atmosphere for your
slideshow.

= Record narration directly in FotoMagico while your slideshow is playing.

= Precisely control timing and other details of your slideshow.

= Control your slideshows interactively during playback.

= Remote control your slideshow with an iPhone or the remote control that shipped with your Mac.

= Share your slideshows with others in a variety of formats.

If you want to share your finished slideshows with other people who do not have FotoMagico installed
on their computer, you have a host of options that let you do just that, e.g. creating a standalone
player, creating a DVD, or publishing your slideshow to YouTube. Please refer to Sharing Slideshows for
more information.
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'ﬁ' New in FotoMagico 4.0?

Timeline

adds a Timeline view to the existing Storyboard view. While Storyboard view is more suited to add and
arrange slides, the Timeline view is better when you need to fine-tune the timing of your slideshow.
For more information, see Working with the Storyboard/Timeline and Adjusting Timing in the Timeline.

Audio Waveforms and Audio Markers

Syncing audio with the audio in your slideshow has become much easier with the addition of the audio
waveform display. Authoring of audio markers, a feature that has existed for a long time in FotoMagico
has also become much easier to use, now that editing them has been moved to the Timeline.

For more information, see Adjusting Timing in the Timeline.

Multiple Layers

Multiple layers of images, movies, or titles now lets you create effects that weren’t possible before.
Each layer can be animated independently. For example: image slides with multiple titles which are
faded and animated independently, picture-in-picture effects, movies on top of image layers, or
pseudo 3D effects.

For more information, see Working with Layers.

Collapsible Tracks

The Storyboard/Timeline lets you collapse audio or visual (images, titles, movies) tracks to save vertical
screen real-estate, which is especially convenient for small Notebook screens. When visual tracks are
collapsed, you can hover the mouse over a collapsed stack of slides, to automatically expand that
stack. This is a quick and convenient way to see all layers, while still conserving vertical screen real-
estate.

For more information, see Working with the Storyboard/Timeline.

Inline Authoring Help

Both the Storyboard and the Timeline offer inline help by displaying popover alerts for common
authoring errors. These alerts also offer simple one-click solutions to these problems.
For more information, see Working with the Storyboard/Timeline.

Custom Audio Fade-ins and Fade-outs

In previous version of Fotomagico audio fades were dependant on the chosen visual transition between
slides. The new version gives you the option to change fade-ins or fade-outs by dragging the left or
right edges of audio in the Timeline view to change fade-in or fade-out offsets, in addition to
adjusting volume.

For more information, see Adjusting Timing in the Timeline.

Many User Interface Improvements

Fotomagico 4 offers many small improvements to the user interface, including an improved menu
layout. This should help to make your authoring workflow more productive.
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'E' Introducing the User Interface

The user interface in a FotoMagico document window is divided into four main areas:
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1. Storyboard & Timeline

Arrange slides in this area to tell your story. Add slides and audio by dragging images, movies, or
audio files from the Sidebar or a Finder folder to the Storyboard. Drag and drop slides to re-arrange
the sequence. Switch to the Timeline view to fine-tune the timing by adjusting the duration of slides or
transitions. Use the audio waveform or audio markers in the Timeline view to precisely sync the
transitions to your audio.

2. Stage

When a single slide is selected in the Storyboard or Timeline, the Stage displays the layers of the
selected slide. Here the layers can be positioned, zoomed, and rotated. If animation is enabled for this
slide, the layers are displayed twice: the start of the animation is displayed on the left side, and the
finish of the animation is displayed on the right side of the Stage.

3. Sidebar

The Sidebar holds the Image, Movie, and Audio browsers, as well as the Options Inspector. The Image
Browser provides convenient access to your iPhoto, Aperture, and Lightroom libraries. The Movie
Browser provides access to movies and video clips from various sources on your computer. The Audio
Browser provides access to the songs in your iTunes Library and sound effects from iLife applications.
The Options Inspector contains the options that allow you to control various aspects of the slides that
are selected in the Storyboard/Timeline.

4. Toolbar

The toolbar contains buttons for commonly used features. On the left side are the Storyboard,
Timeline, Blank Slide, and Add Title tools. In the middle are the Playback and Share buttons (which
include the Jump to Beginning, Play/Share, and Jump to End buttons). On the right side are the buttons
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Other Windows and Menus

There are other parts of the user interface that are important at various stages of the slideshow
authoring process:

= Preferences - Parameters that apply to FotoMagico as a whole are controlled in the Preferences
window. Open the window by selecting Preferences... from the [Eeiell/Ele[ldell menu.

= Slideshow Settings - Parameters that apply to a slideshow as a whole (for example: stage size,
background color and a watermark image) are controlled in the Slideshow Settings sheet. Open the
sheet by selecting Settings... from the [Sllel=H5e)4 menu.

= Instant Slideshow Assistant - If you want to create a nice slideshow without a lot of effort, create
a new document, add some images, a song, and then choose Instant Slideshow... from the
menu. Select from a few options and then let the assistant create a simple slideshow -
which you can customize later if desired.

= Share Assistant - The Share Assistants helps you share your finished slideshow with others in a
variety of formats. Select an option from the menu or click the Play Fullscreen/Share button.

= Info Panel - The Info Panel displays information about an image, movie, or audio file that is
selected in the Sidebar, Storyboard or Timeline. Open the Info Panel by selecting Get Info from the
21 menu.
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ﬁ' FotoMagico Terminology

Slideshow - Your entire project, which is made up of images, movies, titles, transitions and audio.
Your end product.

Slide - A container that holds visual items (images, movies or titles).
Visual item - A visual item can be an image, a movie, or a title.

Frame - Visual items are displayed in the Storyboard/Timeline with a frame. When selected, the
frame highlights blue.

Thumbnail - A reduced-size of an image, movie, or title to help recognize the visual item.

Transition - The effect applied between two consecutive slides. There are many types of transition
effects. The most common ones are Dissolve, Fade, and Cut.

Transition Interval - The Timeline depicts the transition interval as a stairstep shape. Drag the
lower-left edge to change the slide duration of the previous slide. Drag the upper-right edge to
change the transition duration itself.

Image item - A single-still image you add to a slide.

Title item - A text element you add to a slide.

Movie item - A Quicktime movie you add to a slide.

Audio item - A song or other audio file that is added to the slideshow.

Audio track - An entire track of audio, which includes music, audio effects, and voice-over or
narration.

Playhead - The thin vertical line with the blue triangle at the top that you drag horizontally in the
Storyboard or Timeline to move to a location.

Geometry - The parameters (position, zoom and rotation) of a visual item that determine where it
shows up on the Stage. The geometry applies to both the start and finish of a visual item.

Animation - Moving from the start geometry to the finish geometry of a visual item creates an
animation. In the Stage, the start of the animation displays on the left side, and the finish of the
animation displays on the right side.

Jog wheel - The wheels that display when a slide is selected to adjust the Zoom and Rotation of
the selected visual item.

Timescale slider - (Timeline view only) Allows you to drag the slider to increase and decrease the
horizontal scale of the Timeline.

Audio marker - Thin red lines that display in the audio waveform (of the Timeline) or in the
toolbar (of the Storyboard) that are manually added to indicate a location in the audio. Right-click
or double click on the marker to display audio marker information.

Fade-in - A gradual increase in volume at the beginning of an audio item.
Fade-out - A gradual decrease in volume at the end of an audio item.

Duration - The total time of a slide or how long the animation of the slide takes.
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'ﬁ' Getting Started

This section explains how to create your first slideshow. Let's assume you created an album called "My
Slideshow" in iPhoto, which contains all the images you intend to use in your slideshow.

| © The following steps also apply if you prefer to use Aperture or Lightroom instead of iPhoto as
your image library.

1. Launch FotoMagico

An empty document appears, or if you didn't set the Preferences to create an empty document upon
launch, you need to create one in the following step.

2. Create a new document

Choose New from the menu or press the 38 N keys.

3. Select a desired display device

An assistant appears which lets you select the desired display device. For example, a computer screen,
a television, or a projector. In this tutorial, select Monitor and the Display of this Macintosh radio
button. Then click the coose | button.

4. Show the Image Browser

The Stage and the Storyboard are both empty. If the Sidebar does not display the /mage Browser, then
press the 8 1 keys to display the /mage Browser. The table (or popup menu) at the top of the
Image Browser lists the iPhoto library and all iPhoto albums. Select the album called 'My Slideshow'
from this table (or popup menu). The Image browser displays all images in this album.

|  If you have a lot of albums in your image library, this popup can quickly grow too long to be
useful. In this case it is easier to drag the divider below the popup downwards, so that the
popup changes to a scrollable list view.

5. Drag images from the Image Browser to the Storyboard

Click in the Image browser to select a single image or press the 38 A keys to select all images. Then
drag the images to the Storyboard at the bottom of the window.
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6. Add Audio

Click the Audio button in the Toolbar to reveal the Audio Browser. Select a song from your iTunes
music library and drag it below the first slide in the Storyboard. Please note the yellow highlight, which
indicates the range of slides that the song will occupy.
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7. Preview the Slideshow

Click the Play Preview button (Spacebar key) or select Play Preview from the [Slls[5536l02 menu.The Play
Preview button changes to a Pause button and a Stop Playback button appears. To exit preview, click
the Stop Playback button.

®

8. Setup Instant Slideshow

Press & * to open the Instant Slideshow assistant from the [Elllc[5516)4] menu. Instant Slideshow
applies default settings, including transitions and animation, to your slideshow. Leave everything at the
default settings and click the [ o< | button. Then press the Play button to preview your slideshow.

9. Save the slideshow

Save by pressing 88 S or choose Save from the [[#l[&l menu.

10. Play the slideshow full-screen

Click the Play/Share button, then choose Play Fullscreen or select Play Fullscreen from the [Slle[E5a6)0)
menu. If you have more than one display connected to your Macintosh, a window appears to let you
choose the display that should be used for the presentation.

While the slideshow is playing you can stop it at any time by pressing the Esc or by
pressing | 8 . keys.

[0



11. Add a Blank slide

A blank slide is helpful when you want to add an introductory title to your slideshow. Drag the
Playhead to the beginning of your slideshow (or press the Jump to Beginning button) and click the
Blank Slide button. An outline of a slide appears in the Storyboard and black appears in the Stage.

’ 6,05

12. Add a title

To add a title to the beginning of your slideshow, click the blank slide you just added, then click the
Add Title button. A grey outlined box appears in the Storyboard over the blank slide and in the Stage
area. Click the Title and enter new title text. Use the [[Feldii:is) menu options to change the color, font,

and size of your title.

| You can add blank slides and titles anywhere in your slideshow.

13. Switch to Timeline view

Click the Timeline button. The Storyboard view switches to the Timeline view. Timeline view allows you
to fine-tune the duration of each of these images or movies, and the duration of the transitions directly
in the Timeline.

You can use the Timescale slider to enlarge or decrease the size of the Timeline. This allows
= you to see more or less of the slides in the Timeline.
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14. Fine-tuning the Timing

In the Timeline, click on the vertical edges of each slide (circled in red) and drag horizontally to adjust

the slide duration or the transition duration. Experiment a while with this technique. Press the Preview
button to play the slideshow again.

15. Save the Slideshow again

1"
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'ﬁ' Working with the Storyboard/Timeline

At the bottom of a FotoMagico document window you can see the Storyboard or the Timeline. The
Storyboard and Timeline are views into your slideshow data. They allow you to create and edit your
slideshow. You can use both views to perform most of the same functions, however, some tasks are
easier to achieve in one view than the other. You can only display one view at a time. Use the
Storyboard button or the Timeline button to toggle between the two views. You can also toggle
between the two views by choosing the appropriate menu commands from the menu.

The Storyboard is generally used for adding and rearranging slides (image, movies, titles) or audio. The
Timeline on the other hand is helpful for fine-tuning the duration of slides and transitions, and editing
audio items by using the audio waveform feature.

In addition, you can perform most of the same actions by clicking somewhere in the Storyboard or
Timeline, selecting from the [NEMl menu, or working in the Options Inspector; but often they are easier
to achieve by clicking directly in the Storyboard/Timeline. If you want to change parameters for a
multiple selection however, then you must use the Options Inspector.

When to Use Storyboard View
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= Storyboard view is very useful to help start your slideshow by dragging images from the Image
Browser to the Storyboard, and for rearranging slides by dragging them within the Storyboard.

= Slides display as the same size square frame (which always takes up the same amount of space,
regardless of the duration). You can see a larger number of slides at the same time, so you get a
better overview. This is useful when adding new slides or rearranging slides via drag & drop.

= Thumbnails of images, movies, and titles are larger, making it easier to recognize each thumbnail
image.

When to Use Timeline View

FotoMagico 4 Help - Copyright © 2007-2012 IMAGINE. All rights reserved.
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= Timeline view allows you to be more precise and is best for fine-tuning slides and transition
durations.

= You can see fewer slides, but you can see more properties for each item in the Timeline.

= The Timeline view depicts slides as rectangular bars with the width being proportional to the
duration. The transition interval, where both the incoming and outgoing slides overlap, is drawn as
a “stairstep” shape. Dragging the lower left edge of this interval allows you to change the slide
duration, while dragging the upper right edge allows you to change the transition duration.

= The Timeline view also provides an audio waveform display which allows you to locate an exact
position in a song.

= Audio markers are used to synchronize slide transitions with the beat of the music by placing a
marker at an exact location in the audio. Using audio markers along with the audio waveform helps
to visually place the marker on the beat of the music. Audio markers display as a vertical red line
on top of the waveform. (For this release, audio markers have been moved from the Audio options
to the Timeline.)

For more information, see Audio Markers.

= Dragging the left or right edges of an audio item in the Timeline, changes the fade-in or fade-out
offsets. Dragging the yellow dots of the volume envelope (only visible when audio is selected)
changes fade-in/out durations. Dragging the horizontal part of the volume envelope changes
volume.

Drag & Drop in the Storyboard/Timeline

Dragging slides into the Storyboard behaves differently, depending on whether you drag a single item
or drag multiple items. A yellow highlight indicates where the dragged items will end up when being
dropped. When dragging multiple items, only an insertion between existing slides is possible. When
dragging a single item, then adding a new layer to an existing slide, or replacing the media file of an
existing layer is also possible.

Inline Authoring Help in Storyboard/Timeline

Virtually all icons that appear on various items in the Storyboard/Timeline can be clicked to reveal a
popover that communicates a notice or some kind of issue. The popover explains the situation and
offers buttons with potential solutions.



Image Excessively Large

With a size of 5142x3428 and a zoom factor of 37% the
image 20060830_jh0373.jpg is much larger than
NEeCessary.

This may cause timing problems when playing the
slideshow, since loading the image takes longer than
necessary. You may want to consider scaling down this
image.

| Scale Down Image | | Scale Down All Images |

| M. a8 |

About Tracks in Storyboard/Timeline

Using multiple tracks requires more vertical space in the Storyboard/Timeline, which might present a
problem on smaller screens (for example, on a MacBook). For this reason, you can expand and collapse
the visual and audio tracks. Click the Visual or Audio track icon in the lower left corner of the window
(below the Storyboard/Timeline) to expand or collapse the tracks.

= &
Blue indicates the track is expanded, grey indicates the track is collapsed. The same commands are

also available in the menu. When visual tracks are collapsed, the layers are displayed as a stack
of frames, which auto-expand when hovering over the stack.

14
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ﬁ' Adjusting Timing in the Timeline

This section describes how to adjust slide durations, audio fade-ins/fade-outs, audio volume and sync
images to audio.

Adjusting Duration Manually

The Timeline view displays slides as a rectangular bar the width being proportional to the slide
duration. The longer the duration, the wider the rectangular bar. Where a slide overlaps with the next
slide, a “stair step” shape is displayed. This stair step is called a Transition Interval. The middle of the
Transition Interval displays as an icon that indicates the type of transition. When you drag the lower
half of the vertical edge (A), you adjust the duration of the slide. When you drag the upper half of the
vertical edge (B), you adjust the transition duration.

Duration of Duration of
Transition Interval Transition Interval
L EE— —
o 4
—
Slide Duration

To adjust durations in the Timeline:

1. Select a slide in the Timeline.

2. Use the Timescale slider to enlarge the slide in the Timeline. This will help to precisely click and
drag the edges of the slide to adjust the duration.

Timescale: :l;}=r

3. To see the duration change in real-time, click the Options button in the toolbar to open the Options
Inspector.

o
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4. To adjust the duration of the transition, click the upper half edge (B) and drag to the left or right.
The cursor changes to a directional arrow as you drag, and the width of the transition interval
changes. In the Options Inspector, the transition duration changes as you drag to the left and right.

5. To adjust the duration of the slide, click the lower half edge (A), and drag to the left or right. The
cursor changes to a directional arrow as you drag and the width of the slide changes. In the
Options Inspector, the slide duration changes as you drag to the left and right.

Working with Audio in the Timeline

The Timeline displays audio waveforms, which helps to visually sync your slideshow with your audio. In
addition, you can precisely and easily sync audio by using audio markers directly in the Timeline.

You can change audio fade-ins or fade-outs by dragging the left or right edges of audio in the
Timeline view to change the fade-in or fade-out offsets, change the length of the audio item, and
adjust the volume.

By default, the audio fade-ins and fade-outs are determined automatically - depending on the chosen
visual transition between slides. To use custom fade-ins or fade-outs, either drag the left or right
edges of the audio, or deselect the Automatic checkbox in the Audio Options Inspector and use the
offset and duration sliders.

The following example shows the Timeline view displaying an audio waveform in a music track with red
vertical lines indicating audio markers, and some voiceover (with waveforms) in the narration track
selected with the volume envelope displayed (yellow line with the dots).

16
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To adjust the audio fade-in and fade-out and adjusting volume:



1. In the Timeline view, select an audio item. The audio item highlights in blue and a yellow line with
two dots at each end appears.

2. Click the Options button to show the Audio Options in the sidebar.

3. You can uncheck Automatic next to the Fadein and Fadeout options, or as you drag the yellow dots
in the Timeline, the Automatic option is turned off. This allows you to manually adjust the offset
and the duration of the audio fade-in or fade-out with the sliders.

If you want to go back to the default settings anytime, check the Automatic option again.

-3
-

4. To adjust the fade-in duration, click and drag the left yellow dot horizontally. To adjust the fade-
out duration, click and drag the right yellow dot horizontally.

5. To adjust the audio volume, click and drag the yellow horizontal line up or down. Dragging up
increases the volume, dragging down decreases the volume.

Syncing with the Audio Waveform and Adding Audio Markers

The audio waveform in the Timeline view displays a sample plot of the volume (amplitude) of an audio
file. Waveforms display for all audio tracks (music, effects, narration) in the Timeline.

This visual representation of the audio waveform allows you to locate certain points of a song (effect or
narration) by identifying big amplitudes (louder sounds) or low amplitudes (softer sounds). You can
then match slide durations to beats in the audio. For example, you might want to start a title at a
certain point when the audio increases in volume. The waveform helps you to visually pinpoint the
exact location. As you locate and sync these locations in the waveform, you can add an audio marker
to indicate a specific location.

You can add an audio marker by right-clicking in the waveform and selecting Audio Marker > Add
from the context menu or by pressing the M key in the Timeline while the slideshow is playing. An
audio marker in the Timeline is indicated by a thin red vertical line.

For more information see Audio Markers.

To sync your audio:

1. With audio and images loaded in your slideshow, click the Timeline button.
The audio waveform displays in the audio tracks. If you don’t see all the tracks of audio displayed,
click the Audio tracks icon at the bottom of the Timeline or press Ctrl A . a blue icon indicates
that the tracks are expanded, a grey icon indicates that the tracks are collapsed.

=&

2. Select a single audio item (by clicking on it), and then click the Preview button in the toolbar to start
playing the slideshow.

3. While the slideshow is playing, press the M key with the beat of the music.
Each time you press the M key, an audio marker is created at the current time. A red vertical line
appears as an audio marker. The slide’s Continue type is automatically set to “At Audio Marker.”

17



4. Stop playback of the slideshow by clicking the Stop button in the toolbar.

5. Click on an audio marker (red line) and drag it left or right to move it to the desired location, if it
was not precise enough before.

6. Double-click an audio marker (red line) to display an information popover.

Audio Marker 57
Timecode: |[0:03:05.150 =
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7. Enter a name for the audio marker.
You can also adjust the timecode if needed, by clicking the up and down arrows in the Audio
Marker window. Click outside the popover to close it.

8. Add additional audio markers by right-clicking in the waveform and selecting Audio Marker >
Add from the context menu.

Audio Markers

Audio markers are used to synchronize slide transitions with the beat of the music or with certain parts
of recorded narration. Authoring of audio markers has been moved from the Audio Options Inspector
to the Timeline view. Creating and editing audio markers requires the following steps:

= Select a single audio item in the Timeline and preview your slideshow. When you want a transition
to occur, press the M key. This adds a new audio marker. The marker is displayed as a red line in
the audio waveform.

= Another method to add an audio marker is to select a single audio item, then click and drag the
playhead to scrub through the slideshow. When the playhead is at the desired location over the
audio waveform, press the M key to add an audio marker, which appears as a red line.

= Alternatively you can right-click on a location in the audio waveform and select Audiomarker >
Add from the context menu (if you are not currently previewing the slideshow).

= To remove an audio marker, right-click an audio marker in the Timeline and select Audiomarker
> Delete from the context menu.

= Once you are done setting all your audio markers drag the playhead to the beginning and play
again to review the markers. The LCD view will flash in red when an audio marke5 is passed.

= If an audio marker is not set correctly, you can adjust its position by dragging it to the correct
location in the waveform or by editing its timecode. Double-click a red line in the Timeline to open
a popover and edit the timecode.

= Markers can also be given a name. Double-click a red line in the Timeline to open a popover and
simply type the name in the popover. The name is for reference only and does not have any
influence on playback.

18
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= Once you are satisfied with the audio markers, go to the Slide Options Inspector and set the

Continue Type of the slides above the audio item to Continue at Audio Marker.

With audio markers you can synchronize slide transitions with the beat of your music. If audio
markers are placed fairly close together, exact timing cannot be guaranteed. FotoMagico
needs to load media files for the next slide before it can proceed to this slide. If an audio

marker was missed in the process, the transition to the next slide will occur when another
audio marker is passed.

{ ° This limitation only applies to a live presentation. When exporting your slideshow to a
QuickTime movie, the exact timing is always respected.
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'E' Working with the Stage

The Stage takes up the largest part of the document window. It displays the visual items (layers) of the
currently selected slide. A visual item may be an image, a movie, or a title. These visual items can be
sized and positioned on the Stage.

The Stage displays directly above the Storyboard/Timeline view. When a single slide is selected in the
Storyboard/ Timeline, the slide is displayed on the Stage. If Animation is turned in for this slide, then
the Stage displays two parts, the left side displays the start of an animation and the right side displays
the end or finish of the animation. All layers contained in a single slide are displayed on the Stage.

Within the Stage, you can move, zoom and rotate each individual layer of a slide. There are several
different methods you can use to manipulate and edit your slide. You can click and drag a layer, use
the jog wheels, or edit the zoom and rotation values numerically. For more detailed information, see
The Stage in the Reference section.

To drop and edit an image in the Stage:
1. Select a single slide in the Storyboard/Timeline

2. Drag a single image from the Image Browser or from the Finder.

3. Drop the image in the Stage. A new image layer is added to the slide. A white outline indicates the
image layer is selected.

4. Click on the new layer and move the image to any location in the Stage. A hand cursor is visible
while you are doing this. Moving the image in the Start window affects the start of the animation
and moving the image in the Finish window, affects the end of the animation.

’_; TIP: When dragging layers, you can use the snap to stage boundaries (green guidelines),
= or edges of other layers (yellow guidelines). Click the Control key to temporarily disable

snapping.

5. To zoom or enlarge the layer, click the image to select it and then drag a corner of the selected
white outline, or Option+click and drag the mouse up and down. You can also use the Zoom jog
wheel to enlarge your image or enter a percentage in the Zoom text box.

6. To rotate the layer, click the image to select it and then drag the sides of the selected white outline
(a rotate cursor appears), or Command+click and drag clockwise or counter-clockwise. You can
also use the Rotate jog wheels to rotate your image or enter a degree value in the Rotation text
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7. Continue to add additional layers to the slide by dragging to the Stage again. A slide can have up to
six layers.
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’ FotoMagico 4 Help > Guides > Working with Layers

'E' Working with Layers

Layers are a way to add multiple images, movies, or titles to a slide. For example: you can have a slide
with one image and multiple titles, a picture-in-picture slide, or a slide with a movie on top of an
image. There are numerous creative ways to use layers. Each layer can be animated and faded
independently. A slide can have a total of six layers, regardless of the layer type (image, movie, or
title).

If the visual tracks in the Storyboard/Timeline are collapsed, the layers of each slide are displayed as a
stack of frames, keeping everything neat and organized. When you mouse-over the stack, the layers
(images, movies and titles) associated with that slide autoexpand so you can see each frame (and its
thumbnail).

‘ﬂf
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When visual tracks are expanded, you can always see all layers, but the Storyboard/Timeline requires
more vertical space, while the Stage will be given less vertical space. You can always toggle this
setting, depending on whether you are currently focusing on the Storyboard or the Stage.
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Adding Layers to an Existing Slide

You can add up to six layers to an existing slide. A layer can contain an image, a movie, or a title. You
can do this in the Stage or in the Storyboard/Timeline.

When using the Stage, make sure that only the slide you are adding to is selected in the Storyboard. Its
layers are displayed in the Stage. Drag a single image or movie onto the Stage to add the layer.

When dragging a single image or movie to the Storyboard, a yellow highlight indicates where the new
layer will be added.

To add an image layer:

1. Drag a single image from the Image Browser or from the Finder.

2. Drop the image in the Stage or in the Storyboard. When dropping in the Storyboard, a yellow
highlight indicates where the image will be added. Make sure to drop it above an existing layer.
The newly added layer is automatically selected.

3. You can then move, zoom, or rotate the new image layer in the Stage to achieve your desired
effect.

To add a movie layer:

1. Drag a single movie from the Movie Browser or from the Finder.

2. Drop the movie in the Stage or in the Storyboard. When dropping in Storyboard, a yellow highlight

23



indicates where the movie will be added. Make sure to drop it above an existing layer. The newly
added layer is automatically selected.

3. You can then move, zoom, or rotate the new movie layer to achieve your desired effect.

To add a title layer:

1. Click the Add Title button in the toolbar.
2. A new title layer appears in the Stage, ready to edit.

3. With text already selected, enter your title text.

4. When done, press the Enter key or click outside the title layer.

5. You can then move, zoom, or rotate the new title layer to achieve your desired effect.
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'ﬁ' Working with Chapters

If your slideshow is very long, chapters can help to structure your slideshow into logical parts. Chapters
offer several benefits during authoring and playback, they include:

= Chapters can be collapsed or expanded in the Storyboard. Collapsing chapters that you are not
currently working on saves a lot of horizontal space and thus less horizontal scrolling is required.

= Chapters can have custom background colors. Color coding your chapters help with quick
navigation as you are working on large projects. Instead of looking for particular thumbnails as you
are scrolling through your Storyboard, simply look for the correct chapter background color. You
can assign colors based on the status of the chapters: Red for needs work, Yellow for minor tweaks,
and Green for done.

= Chapters can have a custom hotkey, which can be used for navigating during authoring and
playback.

= During playback you can jump to the start of the previous or next chapter. If assigned custom
hotkeys to your chapters, you can also jump to any chapter during playback.

To create a chapter:

1. To create a new chapter, move the Playhead in the Storyboard or Timeline to the first slide of the
intended new chapter.

2. Select Chapter > Add from the [Slls[55:e08 menu or Control+click in the Storyboard to display
the context menu. A new chapter is added next to the playhead and the default name is selected so
that you can enter a custom name for the new chapter.

3. Press +' when you are finished typing the name.

4. Select Chapter > Options... from the [Sl[E5:600A menu or from the context menu to open a
popover that lets you edit additional chapter parameters like background color and a hotkey.

Mame: MNew Chapter '

C::rl::rr:[ H = H E NN

Hotlkey: Click to record shortcut
T SO B, O T 5,05
- Mew Chapter

To delete a chapter:

1. To delete an existing chapter, move the Playhead in the Storyboard or Timeline to the first slide of
the chapter.

2. Select Chapter > Delete from the [Slls[=55e002 menu or Control+click in the Storyboard to display
the context menu.

FotoMagico 4 Help - Copyright © 2007-2012 IMAGINE. All rights reserved.
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To collapse and expand chapters:
You can collapse a chapter, to take up less horizontal space and thus a lot less scrolling is required to

move around in your slideshow. You can also expand a chapter that you are currently working on, to
easily focus on a specific chapter.

1. To collapse a chapter, click on the small triangle next to the chapter name. If you press the X key
and click on the small triangle all chapters will collapse.

17,55
B New Chapter -

2. To expand the chapter, click on the small triangle again. If you press the X key and click on the
small triangle all chapters will expand.

Marker Marker ' Marker ' Marker Marker
- Mew Chapter 3 1 i :

3. To expand or collapse a chapter you could also select Collapse Chapter from the menu or
Expand Chapter , if the selected chapter is collapsed. To collapse or expand all chapters use
Collapse All Chapter or Expand All Chapter from the menu.

To move from chapter to chapter:
1. To move the Playhead from one chapter to the next, press the X key + the — or « arrow
key.

2. If you assigned a hotkey to chapters, you can also move from one chapter to the next by pressing
the hotkey.

To assign a color to a chapter:
1. Move the Playhead in the Storyboard or Timeline to the first slide of the chapter.

2. Select Chapter > Options... from the [Slle[5516)04 menu or Control+click from the context menu.
A popover opens that lets you edit additional chapter parameters.

3. Click a color to assign to the chapter. The color is displayed in the slide background.

4. To remove the color, click the X.



FotoMagico 4 Help > Guides > Creating a Template Slideshow

'ﬁ' Creating a Template Slideshow

Templates are an easy way to quickly create new slideshows that don’t need a whole lot of changes. By
using an existing slideshow, you can easily save the slideshow under a new filename and simply
replace the images of existing slides to create a new slideshow based on the old one. For example, you
can create a Wedding Template or a Senior Portrait Template, which already contains all slides, titles,
and music. When you get the job to produce another wedding slideshow, just use this template and

replace the existing images with the new ones.

You can replace images in the Stage, as well as in the Storyboard and Timeline view. Since the
thumbnails are quite small in Timeline view, working in in the Storyboard or Stage is usually easier.

To create a template:
1. Open an existing slideshow document.

2. Select Save As... from the [z}l menu. The Save As dialog opens.
3. Enter a new filename for your slideshow, then click Save.

4. To replace an image, drag the new image from the Image Browser or Finder and drop it onto the
thumbnail in the Storyboard. You can also drop the image directly onto a layer in the Stage while
pressing the Option key. The image you want to replace highlights in yellow.

5. You can replace the movie file of an existing movie layer in the same way.

6. To replace audio, drag an audio file from the Audio Browser or the Finder onto an existing audio
item in the Storyboard. When it highlights yellow, drop the file.

To make replacing in the Stage even simpler, right-click on a layer in the Stage and select
= File > Is Placeholder from the context menu. Once a layer is a placeholder, pressing the
Option key is no longer necessary for replacing. This should be done in the original

slideshow before it was saved under a different filename.
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'ﬁ' Playing Slideshows

There are two options for playing a slideshow: previewing in the document window and playing in full-
screen mode. If you have multiple displays connected to your computer, or if you have a projector
connected to your Mac, you can choose any of those displays or the projector for a full-screen
presentation.

When playing your slideshow, FotoMagico tries to respect the timing you specified during

authoring. However, if slide durations are fairly short, and the image files are large, your
computer may not be able to load the image files quickly enough to keep up with the fast
pace you specified.

In this case you can either slow down the pace by making the slide durations a bit longer, or
you can scale down your image files, so that loading doesn't take as long.

i

Previewing in the Window

To preview part of your slideshow, click on the Preview button in the toolbar (filled triangle), choose
Play from the [Sllc[sH5e)2 menu, or press the Spacebar key.

®

If you want to stop the preview, click the Play button again, or choose Stop from the [ElE[E516104 menu,
or press the Esc orthe 3 . keys.

Playing in Fullscreen Mode

To play the slideshow, first click on the Rewind button to move the playhead to the beginning of the
slideshow, then click on the Play Fullscreen/Share button in the toolbar, then choose Play Fullscreen...
or choose Play Fullscreen... from the [Sl[E5160A menu.

If there is more than one display device available (e.g. a projector connected to your MacBook Pro), a
sheet will appear which lets you select which display should be used for full-screen playback. This
sheet looks similar to the Displays pane in the System Preferences.

If you want to stop the slideshow, press the Esc or the 38 . keys or click the Menu button on the
Apple remote control.

Using the Teleprompter

The teleprompter helps you with live narration of your slideshow while presenting it in front of an
audience. It displays the slide notes in a scrolling list on the second screen while presenting the
slideshow itself on another screen or projector.

The teleprompter requires that at least two displays are connected to your Mac. One of these may also
be a projector. Since the teleprompter will be displayed in the document window, it will only be visible
if you move the document window to the screen which will not be used for the full-screen
presentation. For example, if you have a projector connected to your MacBook Pro, move the document
window to the internal display, and use the projector for the full-screen presentation.
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Choose Play Fullscreen from the [Slllsls45elif menu and in the sheet that appears select the
presentation screen and 'Use Teleprompter' from the Options popup menu. Playback will start after the
teleprompter has been prepared.

On the left side, the teleprompter displays the current slide, its duration, and a small progress bar
which gives you an idea how long the current slide is still going to be visible. This is helpful to pace
your live narration. The right side displays a scrolling list of slide notes, which remind you of what to
talk about during the slideshow. The notes for the current slide are displayed in bright white, while
notes for upcoming slides are displayed in a dimmed dark gray.

Preparing the teleprompter may take a while for very long slideshows. Playback will start after

the preparation has completed.

Some Macs may not be powerful enough to display both the full-screen playback and the
teleprompter at the same time, without some stuttering occurring in the animation of the

L[

images. In this case you may need to refrain from using the teleprompter.

Interactive Control

Slideshows can be controlled interactively while playing. This interactive control is available when
previewing in a window, playing full-screen, using a standalone player or a screensaver. Playback can
be controlled interactively with the keyboard, the Apple remote control, or mouse clicks:

= Pause/play slideshow - Press the Spacebar key to pause the slideshow or the Play/Pause button
on the Apple remote control.

= Jump forward/backward - Press the — key or the Forward button on the Apple remote control
to advance to the next slide. Press the ¢+ key or Backward button on the Apple remote control to
go back to the preceding slide.

= Volume Control - Use the scroll wheel of your mouse or Apple Remote volume keys to control the
master volume. Lower the volume while you are speaking live and increase it when the music is
more important.

= Continue at mouse click - If your slideshow contains slides with Continue at mouse click, the
slideshow will pause at the end of these slides. Once you click the mouse button, the slideshow will

advance to the next slide.

= Stop slideshow - Press the Esc or 38 . keys to stop the presentation at any time. Image and
audio will fade out before the slideshow stops.

Presenting with the iPhone Remote Application

FotoMagico now supports remote controlling of full-screen presentations with an iPhone app which is
available separately at the iTunes App Store. Find out more about the FotoMagico Remote app and
where to purchase it at www.boinx.com/fotomagico/iphone/.

For help on using the iPhone Remote Control, visit www.boinx.com/fotomagico/support/iphone/.
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ﬁ' Sharing Slideshows

After you have created and played a slideshow in Boinx FotoMagico, you may want to share your
slideshow with others who do not have FotoMagico or even a Mac computer. FotoMagico offers a
variety of options to share your slideshows. You can choose these options from the [EiEIZl menu or
from the Play Fullscreen/Share button:

Creates a stand-alone player application that can be played
= Standalone on an.y Ma'c running Mac .OS X Leopard or later. As a player
. Plaver contains high resolution images and can be controlled
\/ y interactively, it is the best way to share a slideshow with
anybody using a Mac.

Creates a video suitable for uploading to YouTube. After the
You TUbe YouTube video has been rendered and compressed, it will be

automatically uploaded to your YouTube account.

Creates a movie that uses the full capabilities of your
iPhone/iPod. You can choose the iPhone/iPod model and
FotoMagico will use the best possible settings that are
compatible with your selection and the corresponding
recommendations of Apple. You could also add your movie to
iTunes for syncing.

iPhone/iPod

Creates a movie that uses the full capabilities of your iPad.
You can choose the iPad model and FotoMagico will use the

iPad best possible settings that are compatible with your selection
and the corresponding recommendations of Apple. You could
also add your movie to iTunes for syncing.

Creates a movie that uses the full capabilities of your Apple
TV. You can choose the Apple TV model and FotoMagico will

/ Apple TV use the best possible settings that are compatible with your
selection and the corresponding recommendations of Apple.
You could also add your movie to iTunes for syncing.

This plug-in helps you to create a movie that can then be
burned to a DVD using a third-party application such as iDVD
f . DVD or Roxio Toast Titanium. Due to the limitations of the NTSC
P /_, and PAL video standards the result will not look as good as
— the original slideshow, but can be played on any DVD player

connected to a TV or projector.

The QuickTime plug-in gives you access to all the tedious

-
@ QuickTime compression settings of QuickTime. Here you can really fine
Movie tune all aspects and even create preset settings for future
MOVIE
—_ use.

Image Quality and Distribution Reach

Some of the choices listed above provide excellent image quality, but a limited distribution reach, while
other choices reach a wider audience, but with reduced image quality. Keep this tradeoff in mind when
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choosing how to share your slideshow.

Standalone players, screen savers, and presenting from within FotoMagico provide the best possible
image quality, but require an Mac model to present the slideshow. Burning the slideshow to a DVD lets
anybody with a consumer DVD player view the slideshow, but image quality is reduced due to technical
limitations of the video format. Exporting a movie for handheld devices like an iPod, iPhone or iPad will
let you watch a slideshow on the go, but image quality is limited by the LCD screen. Exporting your
slideshow for the web lets anybody watch your slideshow, but image quality is limited by bandwidth
limits of typical internet connections.

How to Share Your Slideshow

Select how you want to share your slideshow from the [SiElil menu or click the Play Fullscreen/Share
button (some selections are only available when pressing the Option / Alt key) to open an assistant,
that will guide you through the process of sharing your slideshow. Click on the Continue button after
entering the necessary information in each page of the assistant.

Standalone players always retain 100% quality because they use the FotoMagico slideshow playback
engine. For this reason they are the preferred choice to share a slideshow at full quality. All other
choices export your slideshow to an intermediate format (usually a QuickTime movie), which results in
some image quality loss.

| « For some choices (e.g. DVD) the quality will always be the same, but in other cases (e.g
QuickTime) the quality can vary greatly, depending on the output size, frame rate, and
compression options that are chosen.

The following pages will explain some common sharing options in more detail:
= Creating a Standalone Player
= Creating for YouTube

= Creating a DVD

» Creating a Custom QuickTime Movie
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'ﬁ' Creating a Standalone Player

Once your slideshow is finished you may want to share it with other people who do not have
FotoMagico installed on their computer. Creating a standalone player is the best option, because it
displays the slideshow with the original FotoMagico playback engine, thus retaining the full quality of
your slideshow.

Select Standalone Player... from the menu or click the Play Fullscreen/Share button. Click on
the Continue button and the assistant will guide you through the necessary steps to create a
standalone player.

Standalone players are compatible with Intel Mac models running Mac OS X 10.6 (Snow

Leopard) or newer, which have a reasonably modern graphics card. Any Mac that is able to
run FotoMagico can also run a standalone player.

If your slideshow has missing images or audio files, you will first see a page that lists the
missing files. If you used protected audio files (songs purchased from the iTunes Music Store),

these will also be listed.

The use of DRM Protected audio is not recommended as it limits the distribution of the player

[0

to 5 different computers, which need to be authorized to play the audio. For this reason it
makes more sense to use unprotected audio.

Step 1 of 4: Provide Info

On the first page of the assistant you can enter information about the author of the slideshow,
copyright info, a web page URL, and a contact email. This information can either be displayed after the
player stops playing the slideshow.

Step 2 of 4: Select Options

Select expiration options. A player can be set to expire after playing the slideshow a certain number of
times, or after a certain date.

Step 3 of 4: Choose Destination

Specify where the standalone player should be saved. FotoMagico will suggest a reasonable filename
and destination folder. Accept the defaults or enter a new filename and destination folder. Please make
sure to select a folder on a volume that has enough free disk space. Also make sure to only select a
folder for which you have write permissions.

If you choose a folder which does not have the correct permissions or if the volume does not
have enough free disk space, then an alert will be displayed at the bottom of the assistant
and the Start button will be disabled. In this case you need to choose a different folder or
different volume.

If none of your volumes have enough free disk space, you need to attach another external
hard disk or free up some space on your internal hard disk by deleting things you do not

[0

need anymore.

Step 4 of 4: Exporting

Click the Start button. The player will be created in the destination folder you specified in the previous

cten The accictant will clace antamatically
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'ﬁ' Creating a YouTube Video

Once your slideshow is finished you may want to share it with others as a YouTube video. In order to
do this, you will need a YouTube account. If you do not have a YouTube account, you need to set one
up on YouTube.

Select YouTube... from the menu or click the Play Fullscreen/Share button. Click on the
Continue button and the assistant will guide you through the necessary steps to create a YouTube
video.

If your slideshow has missing images or audio files, you will first see a page that lists the
=  missing files. If you used DRM protected audio files (songs purchased from the iTunes Music
Store), these will also be listed.

Step 1 of 5: Select Options
Select the video resolution (SD 480p, HD 720p, or HD 1080p).

Step 2 of 5: Choose Destination

Specify where your YouTube video should be saved. FotoMagico will suggest a reasonable filename and
destination folder. Accept the defaults or enter a new filename and destination folder, then click the
Choose... button. Please make sure to select a folder on a volume that has enough free disk space.
Also make sure to only select a folder for which you have write permissions.

If you choose a folder which does not have the correct permissions or if the volume does not
have enough free disk space, then an alert will be displayed at the bottom of the assistant
and the Start button will be disabled. In this case you need to choose a different folder or
different volume.

If none of your volumes have enough free disk space, you need to attach another external
hard disk or free up some space on your internal hard disk by deleting stuff you do not need

[0

anymore.

Step 3 of 5: Upload Information

Enter your YouTube account information and password. Select what type of slideshow (video) you are
uploading from the Category popup, enter the title and a brief description of the slideshow and select
if the slideshow (video) is private.
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Account: Boinx

Passward: |sessssnsd | ) Add ta Keyehain

Category: | Film & Animation

Title: waorld photography
Description:  FataMagico Slidechow

Options: ¥ This videa is private

Cancel Co Back Start

Step 4 of 5: Exporting

Click the Start button. The video will be rendered and saved in the destination folder you specified in
the previous step and then uploaded to YouTube.

Step 5 of 5: Finish Up

Your video may not be available immediately for viewing, because YouTube still needs some time to
process the video. Please be patient. You can also select to embed your YouTube video in your own
web page by clicking the Generate HTML button. Click Finish to close the assistant.
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'ﬁ' Creating a DVD

Many users wish to present slideshows in the comfort of their living room, using their TV set and DVD
player. While this does no justice to the quality of FotoMagico slideshows, FotoMagico helps you create
a DVD of your slideshow. FotoMagico does not burn a DVD directly. Instead it creates a QuickTime
movie file and relies on third party software like Apple iDVD or Roxio Toast Titanium to burn the DVD.

Preparing Your Slideshow

Television sets come in two different shapes: traditional TVs with 4:3 aspect ratio and widescreen TVs
with 16:9 aspect ratio. To make sure that your slideshow looks good on a wide range modern TV, we
recommend that you create your slideshow with a 16:9 aspect ratio. The HDTV (1080) choice when
creating a new slideshow document is the best choice for this, because it creates a high resolution 16:9
slideshow.

If you already have an existing slideshow with a different aspect ratio you may want to go to the
slideshow settings and change the Stage Size by selecting Settings... from the [Sls[=55e0E menu.

O m L

| Settings | Info  Background Watermark

Stage Size: | HD 1080p :| 11920 Ix 1080

For best results set the stage size to the resolution of the display or
projector you intend to use when presenting your slideshow.

Background Color: |-

Options: || Slideshow Loops

Presents the slideshow in an endless loop. Press the ESC key or Cmd-. to
stop the presentation.

Cancel ] [ OK |

Slideshows that do not have the correct aspect ratio can be made to match the aspect ratio of your TV
screen. There are two different choices: Letterboxing and cropping.

Cropping cuts away part of the image to make it match your TV. Letter boxing adds black bars at the
top and bottom of the image. Pillar boxing is a rare case: it adds black bars to the left and right of the

image and only happens if you present a 4:3 slideshow on a widescreen television.
FotoMagico 4 Help - Copyright © 2007-2012 IMAGINE. All rights reserved.
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Exporting Your Slideshow

Select the DVD... option from the menu. An assistant will appear that guides you through
steps necessary to create a DVD.

|  If your slideshow has missing images or audio files, you will first see a page that lists the
= missing files. If you used protected audio files (songs purchased from the iTunes Music Store),
these will also be listed.
) DRM protected audio files cannot be used. We recommend that you burn those songs to an
= Audio CD in iTunes and reimport them back into iTunes. This strips the DRM protection from

the audio files and will lead to minor loss of audio quality, but the resulting audio files can
be used without any restrictions. Please refer to the iTunes Help for details on burning Audio
CDs and importing songs.

Step 1 of 4: Select Options

Select the application which should be used to burn the DVD (Apple iDVD or Roxio Toast Titanium), the
video standard (NTSC or PAL), and the aspect ratio (4:3 or 16:9). The 16:9 choice is only available if the
stage size of your slideshow is 16:9 or wider.

VD
s DVD - Select Options Step 1/4
Burn With: | Toast 5
Video Standard: NTSC s
Aspect Ratio: | 16:9 H

Options: v Anamorphic Pixels
[ High Quality

. Bol 63 L

High Quality Requires More Disk Space

Rendering with high quality produces slightly sharper images and less compression armefans in animated images,
but this requires significantly more disk space for the Intermediate files, Please chedk that you have enough free
spale 0 your hard drive,

- —

Cancel | | Coback | [EContinued]

If the aspect ratio of your slideshow and the aspect ratio does not match, then a yellow
warning will be displayed at the bottom of the page. In this case you need to decide whether
the slideshow should be letter boxed or cropped to match the aspect ratio of the DVD.

|  Letter boxing will add black bars at the top and the bottom of the image, while cropping will
cut away parts of the image to make it match the aspect ratio of the DVD.

Anamorphic Pixels (non-square pixels) is an option to improve output quality, but is only
useful for some DVD burning applications. High quality also improves output quality but takes

_' L

a lot more space on your disk and requires a longer time to render.

The preview on the right side will show you what to expect from each choice. Use the left and right
arrow buttons below the preview to step through each slide of the slideshow.
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Step 2 of 4: Choose Destination

Specify where the intermediate QuickTime file should be saved. This QuickTime file will be used as
input for iDVD or Toast Titanium.

FotoMagico will suggest a reasonable filename and destination folder. If you want, you can change the
filename or destination folder. Please make sure to select a folder on a volume that has enough free
disk space. Also make sure to only select a folder for which you have write permissions.

VD =
= DVD - Choose Destination Step 2/4

Destination File: "World Photography.meov”® in folder "Deskiop” on volume “Macintosh HD®
Cheose... =
-
Required Space: 4,7G8 i

An estimated 0,08y are needed for this file
An additicnal 4, TGE are needed for temporary files
552 BLE are available on volume “Maciniosh HD™,

Destination Is Okay

The chosen destination has enpugh free disk space and the reguired weite permizséons. Click on the “Continwe™
Eutton 1o procecd ©o the mexT S8R,

- —

Cancel | | GoBack | [ Stn

Please note that the required disk space is also displayed. This required space is the sum of the
estimated size of the final output file and the size of temporary files.

o If you choose a folder which does not have the correct permissions or if the volume does not

have enough free disk space, then an alert will be displayed at the bottom of the assistant
and the Start button will be disabled. In this case you need to choose a different folder or
different volume.

If none of your volumes have enough free disk space, you need to attach another external

[l

hard disk or free up some space on your internal hard disk by deleting stuff you do not need
anymore.

Step 3 of 4: Exporting

Once you click the Start button the exporting will begin. Exporting is usually done in 4 steps:
Preparing, rendering video, rendering audio, and compressing video. A progress bar for each step is
displayed at the bottom of the assistant. Depending on the duration of your slideshow this can take
quite a bit of time.
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Step 4 of 4: Finish Up

The slideshow has been exported to a DV file and saved in the folder that you specified earlier. Now
this DV file will be opened in the DVD burning application that you selected before (iDVD or Toast
Titanium).

From here on, you leave FotoMagico and continue your work with the DVD burning application. For
details on working with the DVD burning application refer to the iDVD or Toast Titanium help pages.

Should automatic opening of the QuickTime file in the DVD burning application fail for any
reason, then launch the DVD burning application manually, and then drag the QuickTime file
from the Finder to the DVD burning application.

)

Please note that Boinx Software will not be able to offer support for Apple iDVD or Roxio
Toast Titanium. Should you have problems using these applications, please contact Apple or
Roxio customer support.
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‘ FotoMagico 4 Help > Guides > Creating a Custom QuickTime Movie

'ﬁ' Creating a Custom QuickTime Movie

Should none of the other sharing options be sufficient for your needs, you may want to consider
exporting your slideshow to a custom QuickTime movie. Please note, that this is not for the faint of
heart, as quite a bit of QuickTime knowledge may be required to obtain good results.

Hold the Option key and select QuickTime Movie... from the menu. An assistant appears
that guides you through steps necessary to create a QuickTime movie.

{  If your slideshow has missing images or audio files, you will first see a page that lists the
missing files. If you used protected audio files (songs purchased from the iTunes Music Store),
these will also be listed.

The use of DRM protected audio is hot recommended as it cannot be exported to QuickTime
movies. We recommend that you burn protected songs to an Audio CD in iTunes and re-
import them back into iTunes. This strips the DRM protection from the audio files and will
lead to minor loss of audio quality, but the resulting audio files can be used without any
restrictions. Please refer to the iTunes Help for details on burning Audio CDs and importing
songs.

il

Step 1 of 4: Select Options

Select the size, pixel aspect ratio, frame rate, and the compression options of the exported movie.

If you only specify the width or the height for the QuickTime movie, the missing value will be
calculated automatically. If you specify both the width and height, then this size will be used, even if
the aspect ratio does not match the aspect ratio of your slideshow. In this case you will get radio
buttons that let you choose whether you want to letterbox or crop your slideshow to make it match
your export movie size.

If you specify both width and height, you also get the option to enter a custom pixel aspect ratio,
which may be necessary if your exported movie is indented for video output, which often requires non-
square pixels.

Frame rates between 1 fps and 60 fps are supported. The Motion Blur checkbox will be enabled for
lower frame rate. Using motion blur helps avoid low frame rate artifacts, but rendering times are
significantly increased.

Click Customize... to change the QuickTime compression settings. There are numerous QuickTime
codecs to choose from and each is slightly different, so an explanation in these help pages is not
possible. Please note that some prior knowledge with QuickTime compression settings is required to
achieve good results!

Once you find good settings that lead to acceptable results you may want to save them for
later access. Choose the Save Preset... command from the Settings popup. Specify a name
for the preset file. Then, you can recall these settings by simply selecting the name of the

il

preset from the Settings popup.

Boinx Software Support can help you with specific questions about how to use FotoMagico,
but due to limited resources will not be able to help with general questions about QuickTime
compression settings. You may want to contact Apple Support in this case.

Step 2 of 4: Choose Destination

FotoMagico 4 Help - Copyright © 2007-2012 IMAGINE. All rights reserved.



filename, but you can also specify your name and location. Please make sure to select a folder that has
enough free disk space and write permissions.

If you choose a folder which does not have the correct permissions or if the volume does not
haveenough free disk space, then an alert will be displayed at the bottom of the assistant and
the Start button will be disabled. In this case you need to choose a different folder or
different volume.

If none of your volumes have enough free disk space, you need to attach another external

[0

hard disk or free up some space on your internal hard disk by deleting stuff you do not need
anymore.

Step 3 of 4: Exporting

Once you click the Start button the exporting will begin. Exporting is usually done in 4 steps:
Preparing, rendering video, rendering audio, and compressing video. A progress bar for each step is
displayed at the bottom of the assistant. Depending on the duration of your slideshow this can take
quite a bit of time.

Step 4 of 4: Finish Up

The slideshow has been exported to a QuickTime movie. You may now further process it in QuickTime
Player or other video editing applications like iMovie or Final Cut Pro. Click the Open in QuickTime
Player button to open the movie or click the Reveal in Finder button to locate the file.

Provided that you used the correct settings, you can also create a DVD with iDVD, Toast
= Titanium, or DVD Studio Pro. Simply drag the exported movie file to your DVD authoring
application of choice and proceed from there.
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ﬁ' FotoMagico Preferences

This is where you apply settings that affect the application's behavior globally. To open the preferences
pane, select Preferences from the [feiiel\/Ele[ldell menu or press & ; . Preferences are grouped into five
different areas, each of which is represented by a tab in the preferences window:

General

Create new document at application launch - when checked, this will create an empty document
after launching the application.

Show assistant when creating new document - opens an assistant that guides you through the
process of setting up a document.

External editors - lets you choose applications for editing images, movies, and audio files.

Number of undo steps - enter the number of undo steps you can perform, default is 10.

Libraries

Media libraries - lets you choose whether iPhoto, Aperture, Lightroom, iTunes and Flickr libraries
should be loaded. Excluding some libraries reduces the memory footprint and loading times.

Browser appearance - determines how image and movie thumbnails are being displayed in the
Image Browser and Movie Browser. Choose whether thumbnails should be displayed with a border,
shadow, and name. The background color for the Image browser can also be selected.

Authoring

The When inserting images section determines which default animation is applied to images that are

added to a slideshow.

Apply automatic animation - When checked a slow animation with alternating zoom in and zoom
out is applied to inserted slides.

Keep landscape images completely visible - When checked a small zoom level is applied, so that
horizontal images are completely visible on the stage. If unchecked, a higher zoom level makes
sure that the image covers the stage and no background is visible.

Keep portrait images completely visible - When checked a small zoom level is applied, so that
vertical images are completely visible on the stage. If unchecked, a higher zoom level makes sure
that the image covers the stage and no background is visible.

If you want more control over the animation, then use the Instant Slideshow... assistant

= from the BIEESIENA menu, or change the settings in the Options Inspector at a later time.

The When adding audio section determines if newly added audio is initially linked to slides. The
audio can either stay where it is, or it can move along with the slides above it as you rearrange
slides. This behavior can be decided for each audio item and can be changed in the Audio Options
Inspector later.

Always link audio to slides - When checked, the audio will always stay with the slides when you
move them.

Never link audio to slides - When checked, the audio will stay where it is. If you move slides, the
audio will not move.
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= Let Fotomagico choose (depending on situation) - When checked, FotoMagico will decide if the

audio should be linked if dropped below the existing slides, or unlinked if dropped into an empty

section in the Storyboard/Timeline.

Playing

Options that apply when playing your slideshow:

= Spacebar preview behaviour - Defines whether pressing the Spacebar key to preview a slideshow
starts/stops playback, or whether it starts/pauses playback.

= De-interlace - When checked video files are displayed with a de-interlacing algorithm. This leads
to much nicer video playback, but this option requires more processing power. If video playback
stutters on your computer, you may want to turn off this feature.

= iPhone Remote - When enabled the iPhone remote application for FotoMagico (separately available
on the iTunes app store) can be used for interactively controlling a live presentation. Enter a PIN
code to protect your Macintosh from unauthorized access to FotoMagico.

Software Update

Determines whether and how often FotoMagico will look for updates. In addition to that, you always
click the Check Now to find out whether a new version is available. You can also decide to send us
information about your system configuration, which allows us to improve support for future releases.

= Never - Never look for new versions of FotoMagico.
= Monthly - Check monthly whether a new version is available.
= Weekly - Check weekly whether a new version is available.

= Daily - Check daily whether a new version is available.



FotoMagico 4 Help > Reference > Slideshow Settings

ﬁ' Slideshow Settings

The settings control important aspects of your slideshow, like the stage size and background color. To
open the settings sheet, select Settings... from the Slideshow menu.

Settings
= Stage Size - The stage size determines the aspect ratio of your slideshow. For best results, choose
a stage size that matches the resolution of your intended display device, like a Cinema Display or a
Full HD projector. If your slideshow is likely to be presented on a variety of different displays, then

select the largest display you are targeting.

The stage size can be changed for an existing slideshow. Please note that aspect ratio
= changes can have unexpected results for slides with pan & zoom animation. In this case
please inspect all slides to make sure everything still looks as intended.

= Background Color - Choose any background color for your slideshow. The background color is
visible when images are zoomed smaller than the stage size. It is also visible on blank slides and

on title slides.

| « Transparent background colors are currently not supported.

= Slideshow Loops - When this checkbox is selected, the slideshow will play endlessly until the Esc
key is pressed. This mode is useful for kiosks or product demos.

Info
Enter slideshow specific information like title, subtitle and description, as well as personal information
like author, organization, copyright, and contact URL in these fields.

Background
Allows you to select a background image for your slideshow. This image is only visible if your slide
images do not cover the entire stage. The background image is not animated.

= Image - Displays the selected image.

= Choose - Click this button to open a file panel and select an image file.

= Remove - Click this button to remove the background image.

Watermark

A watermark (foreground image) is superimposed on every single slide in your slideshow. You can
freely position and zoom your watermark on the stage, but this position cannot change over time, i.e. it

cannot be animated.

A logo or copyright message can be superimposed over your slideshow to create branding for your

work.
= Choose - Click this button open a file panel and select an image file.

= Remove - Click this button to remove the superimposed watermark.

=_Obacitv - Draa this slider to make the watermark nartlv transnarent.
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FotoMagico 4 Help > Reference > Storyboard & Timeline

ﬁ' Storyboard & Timeline

The Storyboard and Timeline view at the bottom of the document window is the main area for
authoring your slideshow. The Storyboard and Timeline view have a header, one or more visual tracks,
and up to 3 audio tracks.

They both allow you to create and edit your slideshow. You can use both views to perform most of the
same functions, however, some tasks are easier to achieve in one view than the other. You can only
display one view at a time. Use the Storyboard button or the Timeline button to toggle between the two
views.

The Storyboard is generally used for adding and rearranging slides. Whereas the Timeline is helpful for
fine-tuning the duration of slides and transitions, and editing audio.

For information on the differences between the Storyboard and Timeline, see Working with the
Storyboard/Timeline.

= The visual track contains the slides. Each slide can hold up to 6 layers (images, movies, or titles).
The layers are displayed as frames that are stacked vertically. A blank slide is displayed as an
empty dashed outline.

= The music track holds audio files. Music can span multiple slides.

= The sound effects track usually holds short audio clips that provide ambience for a single slide, but
may also span multiple slides.

= The narration track holds recorded narration for the slideshow. It can span multiple slides if the
narration was recorded in one session, or can be broken up into several different audio files that
span fewer slides.

= You can expand and collapse the visual and audio tracks. Collapsing reduces the required vertical
space, which is helpful on smaller notebook displays. When visual tracks are collapsed, the layers
are displayed as a stack of frames, which auto-expand when you mouseover the stack.

= Chapters can help structure your slideshow into logical parts. Each chapter would contain a group
of slides and audio items. Chapters can be color-coded for easy identification as you are quickly
scroll through your slideshow.

Dragging to the Storyboard or Timeline

Dragging files from the Finder or from the media browsers in the Sidebar adds new elements to the
slideshow. The yellow highlight on the background indicates where the new items will be inserted or
added.

= Image Files - Inserts new slides with the images at the dropped position.
= Movie Files - Inserts new slides with the movies at the dropped position.
= RTF Text Files - Titles are added to existing slides at the dropped position.

= Audio Files - Audio items will be added starting at the dropped position and will span as many
slides as necessary to cover the length of the audio files. If necessary, empty slides will be added at
the end of the slideshow. You can shorten an audio item by dragging its right edge to span fewer
slides.

| © You can drag an audio file to the Storyboard or Timeline, and then add the images later. This
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workflow is useful for authors who want to start out with pre-composed music and then add
appropriate images after. In previous versions of FotoMagico you always had to start by
adding images first, and then add the music.

Arranging Content

Telling a story is all about arranging your images in a good sequence. To rearrange the content you
can:

= Select images, movies, titles, or audio items by clicking on them. When selected, they highlight in
blue.

= Make a multiple selection by clicking on the background and drag a rectangle across multiple items.

= Make a multiple selection by clicking on the first item, then press the Up Arrow key and click on the
last item.

= Extend the selection by pressing the § key and clicking on another item.

|  Itis possible to make non-consecutive selections. This helps with rearranging your content,
as well as with editing options of multiple items at once.

= Drag selected items to a new location.

| * The dragged items will be inserted in a consecutive fashion when dragging a non-consecutive
selection to a new location in the Storyboard or Timeline.

= Delete selected items by pressing the <1 backspace key or by choosing the Delete item from the
2eflel menu.

= Change the range of slides an audio item spans, by dragging the left or right edge of this audio
item.

= Double-clicking an item reveals the Options Inspector so you can edit parameters for the selected
items.

The Header

The header displays the following information above each slide:

» If a slide is set to continue after its duration, the header displays the slide duration. Double-click
the duration to edit the duration for a single slide.

= If a slide is set to continue at a mouse click, the header displays Click.
= If a slide is set to continue at an audio marker, the header displays Marker.
= Right-click, or Control+click on the text in the header to change the continue type for a slide.

= If the chosen slide duration or transition duration yields problematic timing, a yellow warning icon
is displayed. Click on this icon to show a popover that explains the situation and what to do about
it.

The new warning for problematic timing helps you to author slideshows that are guaranteed

=  to be playable on a wide variety of Macintosh computers. Try to follow the suggestions in the
explanatory popovers.

The Playhead
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The playhead indicates where new slides will be inserted and where playback will start:

= Move the playhead by clicking on the blue triangle and dragging it to a new position.
= Move the playhead by one slide by pressing the left or right arrow keys.

= Move the playhead to the beginning of the previous or next chapter by pressing the Option key and
left or right arrow keys.

= Press the Spacebar key to preview the slideshow starting at the current playhead position.

Multiple Audio Tracks

FotoMagico supports three dedicated audio tracks: Music, Sound Effects, and Narration.

= Use the button below the Storyboard/Timeline to expand or collapse the audio tracks. This helps to
save some vertical screen real estate on small notebook screens. Blue indicates the track is
expanded. Grey indicates the track is collapsed.

WL

= Select Audio>Mute Track from the [HIEESMEWA menu to mute the music track, effects track or
narration track. This mutes all audio in the track. A red x appears when audio is muted. This can
be useful during the authoring process when you want to concentrate on a single audio track and
not be distracted by other audio. To unmute the track, select the same menu item again.

= Select Insert > Record Narration... from the [Slc[25396104 menu to record audio directly to the
Narration track. A panel appears that lets you record the audio. Refer to Record Narration for more
details.

Contextual Menus

A right-click or Control+click on an item reveals a contextual menu. The commands in this contextual
menu depends on which kind of item you click.

Clicking on a visual item:

Menu Submenu Description

. . Enables or disables the animation for the selected
Animation Enabled

slide.

Exchanges the start and finish state of the selected
Reverse . . . .

slide, thereby reversing the animation.
Randomize Sets a random animation for the selected visual item.

Creates a zoom in animation for the selected visual
Zoom In )

item.

Creates a zoom out animation for the selected visual
Zoom Out .

item.
Pan Pans across a panorama image or a vertical image.

Zoom Fill Stage Fills the Stage with the selected item, so that no part

Completely of the Stage background is visible.

Displays the entire image. If the aspect ratio of the
Show Whole Image image differs from the Stage aspect ratio, then some
of the Stage background will be visible.



Layer

File

Chapter

Cut

Copy

Paste

Delete

Clicking on a selected
Menu

Animation

Zoom

Show at 100%
Send to Front
Send Forward
Send Backward
Send to Back
Get Info

Quick Look

Replace Media File

Is Placeholder

Add/Delete

Collapse/Expand

Options...

audio track:

Submenu

Enabled

Reverse

Randomize

Zoom In

Zoom Out

Pan

Fill Stage
Completely

Displays the selected image at 100%.

Sends the selected layer to the front.

Sends the selected image forward.

Sends the selected image backwards.

Sends the selected layer to the back.

Opens or closes the Get Info panel for this item.
Opens or closes the Quick Look panel for this item.

Lets you choose a different media file (image, movie,
or text) for this item. All other parameters will be
kept intact. If you choose an image or movie file
with different dimensions, you will have to make
some additional modifications to restore the
previous appearance.

In a template slideshow some images can be marked
as placeholders. These placeholder images are easier
to replace via drag and drop. Refer to the chapter

Creating a Template Slideshow for more information.

Adds or deletes a chapter at the current playhead
position.

Expands or collapses an existing chapter. Refer to
Working with Chapters for more information.

Opens the options balloon for a chapter. Refer to
Working with Chapters for more information.

Cuts the selected item.

Copies the selected item to the clipboard, so that it
can be pasted into the slideshow somewhere else.

Pastes the copied items at the current playhead
position.

Deletes the selected item.

Description

Enables or disables the animation for the selected
slide.

Exchanges the start and finish state of the selected
slide, thereby reversing the animation.

Sets a random animation for the selected visual item.

Creates a zoom in animation for the selected visual
item.

Creates a zoom out animation for the selected visual
item.

Pans across a panorama image or a vertical image.

Fills the Stage with the selected item, so that no part
of the Stage background is visible.
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Layer

File

Paste

Delete

Show Whole Image

Show at 100%
Send to Front
Send Forward
Send Backward
Send to Back
Get Info

Quick Look

Replace Media File
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Displays the entire image. If the aspect ratio of the
image differs from the Stage aspect ratio, then some
of the Stage background will be visible.

Displays the selected image at 100%.

Sends the selected layer to the front.

Sends the selected image forward.

Sends the selected image backwards.

Sends the selected layer to the back.

Opens or closes the Get Info panel for this item.
Opens or closes the Quick Look panel for this item.

Lets you replace the audio file, while retaining all
other parameters associated with this item. Please
note that any existing audio markers may not be
meaningful anymore and may have to be changed.

Pastes the previously copied audio item to the
position of the playhead.

Deletes the selected audio item.

Clicking on the background of the Timeline or Storyboard:

Menu

Chapter

Insert Blank Slide

Expand/Collapse
Visual Tracks

Expand/Collapse
Audio Tracks

Submenu
Add/Delete

Collapse/Expand

Options...

Description
Adds a new chapter at the current playhead position.
Collapses or expands the selected chapter.

Opens a chapter popover which allows you to enter a
new chapter name, select a chapter color, and create
a hotkey.

Inserts a blank slide at the current playhead
position. Useful for adding titles.

When expanded all visual tracks are displayed
without overlap so that each item is visible. When
collapsed all visual tracks are stacked on top of each
other, saving vertical space.

When expanded all audio tracks are displayed
without overlap so that each track is visible. When
collapsed all audio tracks are stacked on top of each
other, saving vertical space.
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ﬁ' The Stage

The Stage displays the layers of the currently selected slide. The layers can be freely sized, positioned,
and rotated on the Stage. In addition to the slide layers, there may also be an optional background
layer and an optional foreground layer (watermark). Both can be set in Settings... in the [SlEES5e0A
menu.

If animation is enabled for a slide, the stage is displayed twice. The start of the animation is displayed
on the left side, and the finish of the animation is displayed on the right side. That way you can
quickly drag around the layers to create the desired animation effect.

Dragging to the Stage

Dragging files from the Finder or from the media browser in the Sidebar adds new layers to the
currently selected slide:

= Image File - Adds a new image layer to the currently selected slide. If the Option key is pressed,
the layer below the mouse highlights in yellow, and its image file will be replaced instead when you
drop it.

= Movie File - Adds a new movie layer to the currently selected slide. If the Option key is pressed,
the layer below the mouse highlights in yellow, and its movie file will be replaced instead when you
drop it.

= RTF Text File - Adds a new title layer to the currently selected slide. If the Option key is pressed,
the layer below the mouse highlights in yellow, and its title will be replaced instead when you drop
it.

Positioning Visual Items

You can position, zoom, and rotate items on the stage in several different ways:

= Click on an image, movie, or title layer to select it. The item displays a thin white outline and four
resizing handles at the corners to indicate that it is selected. This item will also be selected in the
Storyboard or Timeline.

= Drag the layer around on the Stage to position it.
= Click on one of the resizing handles at the corners and drag to resize the layer.
= Use the jog wheels at the bottom of the stage to change the zoom or rotation of the selected layer.

= Optionally, you can also enter the zoom and rotation value numerically in the text fields above the
jog wheels.

= Press the U key and click on a layer and drag up/down to change the zoom value.
= Press the 3 key and click on a layer and drag around the center to rotate it.

= Click just outside a layer’s boundary and drag to rotate the layer.

Zoom:  GBE% Rotation:  0,0°

L 4o 1




Guidelines

As image, movie, or title layers are positioned, zoomed, or rotated on the Stage, guidelines will appear
to help you align the items. By default items snap to these guidelines:

= Green guidelines help to snap to the center or the edges of the Stage.

= Yellow guidelines help to align an image, movie, or title with itself - on the other side of the stage.
This is helpful when creating certain animation effects, e.g. a completely horizontal pan across an
image, without any vertical motion and no zooming effect.

= Press the Control key to suppress automatic snapping to the guidelines.

Use the yellow guidelines to create perfectly horizontal or vertical panning animations.

i

Contextual Menus

Right-click or Control +click on an item reveals a contextual menu. The commands in this contextual
menu depends on whether an image, a movie, or title was clicked:

Clicking on a slide or title in the Stage:

Menu Submenu Description
. . Enables or disables the animation for the current
Animation Enabled .
slide.
Exchanges the start and finish state of the selected
Reverse . . .
layer, thereby reversing the animation.
Randomize Sets a random animation for the selected layer.
Zoom In Creates a zoom in animation for the selected layer.
Zoom Out Creates a zoom out animation for the selected layer.
Pan Pans across a panorama image or a vertical image.
Zoom Fill Stage Fills the Stage with the selected layer, so that no part
Completely of the Stage background is visible.
Displays the entire layer. If the aspect ratio of the
Show Whole Image layer differs from the Stage aspect ratio, then some
of the Stage background will be visible.
Show at 100% Displays the selected image at 100%.
Layer Send to Front Sends the selected layer to the front.
Send Forward Sends the selected image forward.
Send Backward Sends the selected image backward.
Send to Back Sends the selected layer to the back.
File Get Info Shovys the Info panel for the selected image or
movie.
Quick Look Opens the Quick Look panel which displays the

Is Placeholder

selected image or movie.

Lets you choose a different image or movie file for
the selected layer. All other parameters will be kept
intact. If you choose an image or movie file with
different dimensions, you will have to make some
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Cut

Copy

Paste

Delete

Copy Geometry

Paste Geometry

Copy Animation

Paste Animation

Clicking in Stage background:

Menu

Show Action Safe
Area

Show Title Safe
Area

Submenu

additional modifications to restore the previous
appearance.

Cuts the selected layer.
Copies the selected layer to the clipboard.

Pastes the previously copied layer on top of existing
layers.

Deletes the selected layer.

Copies all geometry parameters (position, zoom,
rotation) of the selected layer to the clipboard.

After changing the selection, the geometry
parameters can be pasted onto another layer. That
way layers can be precisely aligned within a single
slide or across multiple slides.

Copies all animation parameters of the selected layer
to the clipboard, so that they can be pasted to other
layers.

After changing the selection, pastes previously
copied animation parameters onto the selected layer.
That way animation effects can be transferred
between slides.

Description

Displays a dashed rectangle indicating the area of
the stage that is 'safe' for displaying action
(animation).

Displays a dashed rectangle indicating the area of
the stage that is 'safe' for placing titles.
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ﬁ' Image Browser

The Image Browser lets you browse and select images from various sources, like iPhoto, Aperture,
Adobe Lightroom, or any Finder folder containing image files. Choose an image source in the popup or
table view at the top of the Image Browser, then select some images and drag them to the
Storyboard/Timeline or Stage to add them to your slideshow.

Click the Images icon in the Toolbar. The table at the top lists your iPhoto, Aperture, Adobe Lightroom,
or any Finder folder containing image files.

= Drag the divider between the Image browser view to collapse the image source table to a popup
menu, which maximizes the space available for the image browser.

= Right-click on the table background to show a context menu with the Add Folder.. . command.
Select it to add any Finder folder that contains image files to the Image Browser. Optionally you can
also drag a folder from the Finder to the table.

= Right-click on a folder that you added before and select Remove Folder from the context menu to
remove the folder. Please note that this will not delete the folder and the images it contains from
your hard disk.

iPhoto albums are a great way to organize images you might want to use for a slideshow.
= Choose the album from the table (or popup menu), then select all images in the browser and
drag them to the Storyboard or Timeline.

Live Searching

If you want to search for specific images, type a word into the search field below the Image browser.
Searching works best if your image files have been given a caption in iPhoto or Aperture, which is more
descriptive than the filenames assigned by your digital camera.

Get Info

Click on the small Get Info button or choose Get Info from the context menu in the browser to get
information about a selected image.

(@]

Quick Look

Select an image and press the Quick Look button or press & Y or choose the Quick Look command
from the context menu in the browser to open the Quick Look panel. You can then quickly preview
images stepping through them with the arrow keys. Press the Quick Look button or 38 Y again to
close the Quick Look panel.

O

Browser View Types
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and list).
EEl = 3o
Icon Size

Drag the Icon Size slider to enlarge or decrease the size of the image icons displayed in the browser.
This slider is not available in List view.

i "_I,:Iﬁ ]
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FotoMagico 4 Help > Reference > Movie Browser

ﬁ' Movie Browser

The Movie Browser lets you browse and select movies from various sources, like iMovie, or any Finder
folder containing QuickTime movie files. Choose a movie source in the popup or table view at the top
of the Movie browser, then select a movie and drag it to the Storyboard/Timeline or Stage to add them

to your slideshow.

B

Click the Movies icon in the Toolbar. The table at the top lists your Movie, or any Finder folder
containing Quicktime movie files.

= Drag the divider between the Movie browser view to collapse the movie source table to a popup
menu, which maximizes the space available for the movie browser.

= Right-click on the table background to show a context menu with the Add Folder... command.
Select it to add any Finder folder that contain movie files to the Movie browser. Optionally, you can
also drag a folder from the Finder to the table.

= Right-click on a folder that you added and select Remove Folder from the context menu to remove
the folder. Please note that this will not delete the folder and the images it contains from your hard
disk.

= Use the slider below the Movie browser to control the size of the thumbnails.

Live Searching

If you want to search for specific movies, type a filename into the search field below the Movie browser.

Get Info

Click on the small Get Info button or choose Get Info from the context menu in the browser to get
information about a selected movie.

(@)

Quick Look & Previewing Movies

Select a movie and press the Quick Look button or press 38 Y or choose the Quick Look command
from the context menu in the browser to open the Quick Look panel. The movie automatically starts
playing. Press the Quick Look button or 8 'Y again to close the Quick Look panel.

@)

Browser View Types

Select to display the movies in your browser in icon, list, or combo view (a combination of both icon
and list).
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Icon Size

Drag the Icon Size slider to enlarge or decrease the size of the movie icons displayed in the browser.
This slider is not available in List view.
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'ﬁ' Audio Browser

The Audio Browser lets you browse the songs from your iTunes music library, audio files from iLife
Sound Effects, and audio files from any Finder folder you choose to add. Drag songs from the Audio
Browser to the audio track of the Storyboard/Timeline to add them to your slideshow.

DRM protected audio files that were purchased at the iTunes Music Store can be used in your

slideshow for live presentations (provided that your computer is authorized to play those
audio files). However, Apple prohibits exporting these songs to QuickTime movies. For this
reason, those songs will be removed when sharing a slideshow as QuickTime movie, including
DVD or YouTube.

Click the Audio icon in the Toolbar. The popup menu at the top lists your iTunes music library and all
iTunes playlists.

= If you drag the divider below this popup down, the popup changes to a scrollable list, which can be
more convenient, if the popup grows too long to be usable.

= Select a playlist from the popup or scrollable list to display its songs in the table below.

= To reveal additional columns in the Audio browser, drag the divider between the Stage and the
Sidebar to make the sidebar wider. The additional columns will automatically appear as enough
horizontal space becomes available.

= Resize table columns by clicking and dragging column header separators.

= Click in the header of a table column to sort the list by that column.

Live Searching

Use the search field to search your iTunes Library for a particular song. Enter a part of the song title,
the name of an artist or album. The table will list only those songs matching the search term.

Get Info

Select an audio file from the list and click the Get Info button to display the Audio Info panel.

Previewing Audio

When you play audio by double-clicking an audio file or selecting an audio file and pressing the Play
button an LCD display appears below the Audio Browser which allows you to preview audio files.

= Double-click on a song to start playback. When a song is playing, clicking on a different audio file
is enough to play a different song.

= Click on the Play button to start playing the song. The Play button highlights blue.

= Click on the Play button again to stop playing the song.
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Click and drag the diamond shaped playhead to scrub through the song.

= Click the time display to cycle through elapsed (default), remaining and total playing time.

Browser View Types
Select to display the audio files in your browser in icon, list, or combo view (a combination of both icon

and list).

oo f— I:I—l
e = [ o—
Icon Size

Drag the Icon Size slider to enlarge or decrease the size of the audio icons displayed in the browser.

This slider is not available in List view.
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'ﬁ' Slide Options

The Options

Inspector lets you change settings of selected slides in the Storyboard/Timeline. The

Inspector is context sensitive, only those settings applicable to the selected items are shown. You can
make changes to multiple slides at once by selecting several slides in the Storyboard/Timeline before
adjusting settings in the Slides Options Inspector.

The Slides Options Inspector opens automatically when you double-click a slide in the
Storyboard/Timeline.

v Slide

Animation

Continue

Curation:

¥ Notes:

: @ Enabled

L L. » | 8,0s

: | After Duration

Animation

Enabling animation will apply a pan & zoom effect (also known as Ken Burns effect) to all layers
(images, movies, or titles) of a slide. Animation can be turned on with the Enabled checkbox in the

Slide options

, or menu commands available in the Slideshow > Animation menu and various context

menus. The Stage will then display the selected slide twice: the start position of the animation on the
left side, and the finish position of the animation on the right side. FotoMagico will render the motion
between those two positions in real- time.

= Use the mouse or jog wheels in the Stage to apply desired position, zoom level and rotation
settings of your image for both the start and finish state of the animation.

= The Imag

e Options, Movie Options, and Title Options contain a control for fine-tuning the timing of

the animation. Refer to Fine Tuning Animation for more details.

Duration

The duration

determines how long the animation of a slide takes. If the Continue type is set to After

Duration, then it also determines how long the slide is shown before the slideshow advances to the

next slide.

Drag the duration slider from Os to 60s. You can also enter a duration longer than 60s by typing the
value into the text field next to the slider.

you n
for th

The image duration cannot be shorter than the transition duration of the preceding slide. If

eed a shorter image duration for a given slide, you need to decrease the amount of time
e transition of the preceding slide.



get preloaded quickly enough. In this case, the slideshow will advance to the next slide as
soon as the media files of this slide have been loaded into video memory. The amount of time
that is necessary to preload the media files can vary, depending on the speed of your
computer.

Continue

The Continue type determines how and when the slideshow advances to the next slide. There are
several options:

= After Duration - The slide will be shown for the specified duration before advancing to the next

slide. Set the slide duration with the Duration slider or by entering numeric values in the text field.

= At Mouse Click - The slideshow will pause at the end of this slide until you press the mouse
button to continue. Even though the slideshow is paused while waiting for the mouse click, audio
continues to play in the background. In this case you may want the audio loop endlessly.

= At Audio Marker - The slideshow advances to the next slide as soon as an audio marker in the
currently playing audio item is passed.

When selected, these options also display in the header of the Storyboard/Timeline above
each slide as the duration time, Click or Marker

If you choose continue At Audio Marker, make sure the audio item contains enough audio
markers, or your slideshow might get stuck. Read more about audio markers in Adjusting
Timing in the Timeline.

Notes

Use the text field to enter teleprompter notes for the selected slide. These notes will be displayed in
the teleprompter or on the iPhone remote app during a live presentation.
For more information, see Using the Teleprompter.

Using teleprompter notes helps you to remember your live narration during the slideshow.

You can also use the notes field to enter notes or text to yourself about the slides during authoring.
For example, 'replace this image with an updated photo.'
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'ﬁ' Transition Options

The Options Inspector lets you select type, duration, and other parameters for the transition between
slides. To change the transition for multiple slides at once, select the slides in the Storyboard/Timeline
and choose the desired transition type in the Transition Options Inspector.

The Transition Options Inspector opens automatically when you double-click a transition in the
Storyboard/Timeline.

¥ Transition

Type: | [ | Dissolve ]

Duration: q:_1=.'f 1,05

Type
Choose from a list of several transition categories. Many transitions can be customized with sub
options.

The transition type affects both image and audio. For example, if you use a dissolve
transition, and below that transition are two consecutive audio items in the
Storyboard/Timeline, those audio items will be crossfaded. The table below lists each
transition type and how it affects image and audio.

Duration

Drag the Duration slider to set the time that the transition will take to complete. Changing the
transition duration does not change the total duration of the slideshow. In Timeline view, you can see
the width of the transition interval updating in real-time.

The transition duration cannot be longer than the slide duration. If you want a longer
transition duration, you also need to increase the slide duration. Please pay attention to
yellow warning triangles in the Storyboard/Timeline and click on them to read the explanation

i

why some duration combinations are problematic.

Other Options

Depending on the type of transition, you may get options like direction, softness, amount, or 3D. Use
these options to further customize your transition.

Icon  Transition Image Effect Audio
Effect
Simply cuts from the outgoing slide to the incoming one. No
Cut . Cut
additional parameters.
. . . . , . Fade-out,
hd Fade Fades out the outgoing slide and fades in the incoming slide. Fade- in
X Dissolve Cross dissolves from the outgoing slide to the incoming slide. Crossfade
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Linear
Wipe

Circular
Wipe
Angular

Wipe

Slide

Push

Twirl

Flip

Blinds

Cube

Shuffle

Topple

Thumb
Through

Zoom

Aperture

Flash

Pixelate

Creates a wipe effect between the outgoing and incoming slide.
Parameters are softness (0%-100%) and angle (0°-360°).
Softness 0% creates hard edges, while 100% produces a soft
edged effect that almost looks like a dissolve.

Creates a round wipe effect between the outgoing and incoming
slide. Parameters are softness (0%-100%) and direction, which
can be inward or outward.

Creates a 'clock-like' wipe effect between the outgoing and
incoming slide. There is one additional parameter: direction,
which can be left (counterclockwise) or right (clockwise).

Slides the incoming slide over the outgoing one. You can
choose the direction of the slide effect in 90° increments (up,
down, right, left).

The incoming slide pushes the outgoing slide out of sight. You
can choose the direction of the slide effect in 90° increments
(up, down, right, left). The 3D option first pushes the image
away before moving it over.

Creates an effect similar to flushing the outgoing slide down the
toilet. There is one additional parameter: direction, which can
be left (counterclockwise) or right (clockwise).

3D effect that flips over the outgoing slide to reveal the
incoming slide on the backside.

Transitions from the outgoing to the incoming slides with a
venetian blinds effect. You can choose the direction in 90°
increments (up, down, right, left).

The images of the outgoing and incoming slides are displayed
on the faces of a cube. The transition rotates the cube, so that
the current slide is moved out of sight, while the next slide is
moved into sight. You can choose the direction of the slide
effect in 90° increments (up, down, right, left).

Moves the incoming slide from the back to the front, thus
covering the outgoing slide.

Similar to flipping a rolodex card. The outgoing slide falls down,
revealing the incoming slide.

Moves the incoming slide from the back to the front, thus
covering the outgoing slide. Similar to thumbing through a stack
of photos.

Zooms from the current slide to the next slide. Parameters are
zoom factor (2x-1000x) and zoom direction, which can be in or
out.

Simulates a camera lens aperture (iris) effect. A short duration
of 0.5 to 1s work well for this transition.

Simulates a camera flash effect by overexposing images. A short
duration of 0.5s works best for this transition.

Makes the outgoing slide more pixelated while making the
incoming slide less pixelated.

Simulates the effect of a collapsing picture of a broken old

Crossfade

Crossfade

Crossfade

Crossfade

Crossfade

Fade-out,
Fade- in

Fade-out,
Fade- in

Crossfade

Crossfade

Crossfade

Crossfade

Crossfade

Crossfade

Fade-out,
Fade- in

Fade-out,
Fade- in

Crossfade
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Broken TV

Random

Fade-out,

television. Works best with a duration of 3s and a blank slide .
Fade- in

afterwards.

Allows FotoMagico to randomly select transitions. A sheet
appears which allows you to deselect those transitions that you
do not want chosen as random transitions.
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'ﬁ' Image Options

The Options Inspector lets you change settings of selected images in the Storyboard/Timeline. You can
make changes to multiple images at once by selecting several images in the Storyboard/Timeline before
adjusting settings in the Image Options Inspector.

The Image Options Inspector opens automatically when you double-click an image in the
Storyboard/Timeline.

¥ Image
File: 20071125 jh0819.jpg | £,

Border: - ﬂ:.r:"' lpt

Color: _) Normal o,
Visibility: L,
4 :
Animation: £,
h

File

When a single image is selected, the filename of the image will be displayed here. If you want to
replace the image, while keeping all other parameters (animation, color, etc.), select the Replace File...
command from the popup menu next to the filename. You can also select to Reveal the image in the
Finder, or Get Info on the image.

| ~ When you replace an image in a slide, you will probably have to adjust the position and zoom
factors for the new image.

Border

Use this feature to add a border to the selected images. Use the slider or enter a point size to set the
width of the border. Click on the color swatch to choose the border color.

Color

Use this feature to apply non-destructive color correction to the selected images. Color correction can
be used to modify the color tint, saturation, and gamma (lightness) of an image.

Click the Custom color button to open a popover. In the Color palette wheel, click and drag the black
circle to the preferred color, and use the saturation and lightness (gamma) sliders to adjust these
parameters. The image in the Stage adjusts automatically as you make changes.
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Color: | ) Normal | |2,

In the popup menu you can select to copy and paste the selected color correction from one slide to
another, or reset to go back to the original color in the image.

|  The effects of the color correction are visible live in the Stage and Storyboard/Timeline. If you

have multiple slides selected, the Stage is empty and you can see only see teh effects in the
Storyboard/Timeline.
If you have several images of matching color tint, but a few stick out with a different tint, you

= can select these images and adjust their tint to match the other images.
To create a black & white version of an image simply reduce the saturation to 0%.

\al

Visibility

Use the Visibility controls if you don’t want an image layer to be visible during the whole duration of a
slide. Drag in the darker triangles (located on the outside) to restrict visibility to a certain range. Drag
the lighter triangles (located on the inside) (creating a ramp in the curve) to fade-in and fade-out the
image layer. The yellow sections in the bar represent the incoming and outgoing transition intervals.

visibility: |/ Nl 8.
B S

4

The popup menu to the right contains several useful presets: Reset, Fade In, Fade Out, Fade
= In/Out.

Animation

When animation is enabled in the Slide Options Inspector, you can use the Animation controls to fine
tune animation timing. The darker triangles (located on the outside) determine when an animations
begins and ends. The lighter triangles (located on the inside) adjust the fade-in and fade-out of the
animation. Refer to Fine tuning Animation for more details.
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'ﬁ' Movie Options

The Movie Options Inspector lets you change settings of selected movies in the Storyboard/Timeline.
You can make changes to multiple movies at once by selecting several movies in the
Storyboard/Timeline before adjusting settings in the Movie Options Inspector.

The Movie Options Inspector opens automatically when you double-click a movie in the
Storyboard/Timeline.

¥ Movie
File: Logo.mov [+
Volume: « o ) - | 100%

Ducking: | | Lower others by -50%

Border: - o | Ipt

Color: ) Normal o,
Range: [+ B
|
Visibility: | | |2,
A ik
Animation: £,

File

When a single movie is selected, the filename of the movie will be displayed here. If you want to replace
the movie while keeping all other parameters, select the Replace File.. . command from the popup
menu next to the filename. You can also select to Reveal the movie file in the Finder, or Get Info on the
movie.

Volume

Controls how loud the audio of the movie is playing. Set it to 0% if you want the movie to be
completely silent, because you have a song in the audio track instead. Drag the volume slider or enter
a percentage in the text box.

Ducking

When Ducking is enabled, then the volume of other audio tracks is lowered by the specified percentage
while the movie is playing. This is useful to lower the volume of a song in the music track, so that live
sound from the movie can be heard more clearly.

Specifying a ducking factor of 100% means that other audio tracks are completely muted
= while the movie is playing.

Border

Use this feature to add a border to the movie of the selected slides. This allows you to select a border
color from the Color palette and drag the slider or enter a point size to enlarge or decrease the width
of the border.
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Use this feature to apply non-destructive color correction to the movies of selected slides. Color
correction can be used to modify the color tint, saturation, and lightness (gamma) of a movie.

Click the Custom color button to open a popover. In the Color palette wheel, click and drag the black
circle to the preferred color, and use the saturation and lightness (gamma) sliders to adjust these
parameters. The movie in the Stage adjusts automatically as you make changes.

Color; | ) Normal | £,

N e m— ]

In the popup menu you can select to copy and paste the chosen color correction from one movie to
another, or reset to go back to the original color in the movie.

| « The effects of the color correction are visible live in the Stage and Storyboard/Timeline. If you
have multiple slides selected, the Stage does not display a movie, so the effects are only
visible in the Storyboard/Timeline.

If you have several movies of matching color tint, but a few stick out with a different tint, you
can select these movies and adjust their tint to match the other movies.

il

To create a black & white version of a movie simply reduce the saturation to 0%.

il

Range

Set in and out points to restrict the portion of the movie to be played. This is done by dragging the
Range triangles inward. Only the light portion of the bar (between the triangles) will be played. The
movie file itself will not be modified, so all changes can be undone at any time. The movie in the Stage
adjusts automatically as you make changes, displaying the in point on the left side and the out point
on the right side.

For more precise control over in and out points, you can enter an exact in point or out point.
= From the popup menu select Finetune In Point or Finetune Out Point or double-click on the in
point or out point triangle to open a popover to enter an exact timecode.

Visibility
Use the Visibility controls if you don’t want a movie layer to be visible during the whole duration of a
slide. Drag in the darker triangles (located on the outside) to restrict visibility to a certain range. Drag

the lighter triangles (located on the inside) (creating a ramp in the curve) to fade-in and fade-out the
movie layer. The yellow sections in the bar represent the incoming and outgoing transition intervals.

visibility: |/ N e
A b 4
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The popup menu to the right contains several useful presets: Reset, Fade In, Fade Out, Fade
=  In/Out.

Animation

When animation is enabled in the Slide Options Inspector, you can use the Animation controls to fine
tune animation timing. The darker triangles (located on the outside) determine when an animations
begins and ends. The lighter triangles (located on the inside) adjust the fade-in and fade-out of the
animation. Refer to Fine Tuning Animation for more details.



FotoMagico 4 Help > Reference > Audio Options

'ﬁ' Audio Options

The Audio Options Inspector lets you change settings of selected audio in the Storyboard/Timeline. You
can make changes to multiple audio items at once by selecting several items in the Storyboard/Timeline
before adjusting settings in the Audio Options Inspector.

The Audio Options Inspector opens automatically when you double-click and audio item in the
Storyboard/Timeline.

¥ Audio
File: Earthquake.mp3 &,

Options: || Audio Loops
[] Linked to Slides
[EI Locked Timing

Range: -
A h

Volume: e [ ¥ » | 100%

Ducking: | | Lower others by | 50%
b Fadein: [EI Automatic

P Fadeout: Ej Automatic

File

When a single audio file is selected, the filename will be displayed here. If you want to replace the
audio file while keeping all other parameters, select the Replace File... command from the popup
menu next to the filename. You can also select to Show the audio file in the Finder, or Get Info on the
audio.

Audio Loops

If the audio is not long enough for the slides it spans, then selecting Audio Loops makes sure that the
audio is repeated while those slides are visible.

This may be useful for interactive presentations when you don't know how long it will take to
present a sequence of slides.

ik

It may not be appropriate for narration or music that has been carefully synced to the slides

with audio markers.

Linked to Slides

Audio can behave in two different ways when slides are being rearranged. The audio can either stay
where it is, or it can move along with the slides above it as they are rearranged. This behavior can be
decided for each audio item separately and can be controlled by selecting the Linked to Slides option or
by using the command Link Audio to Slides in the context menu of the audio item.

The Authoring pane in the Preferences window has a section that lets you select whether newly added
audio should be linked, unlinked, or whether FotoMagico should choose intelligently (depending on the
situation). In this third case, audio will be linked if dropped below existing slides in the Music or

Narration tracks_ or unlinked if dronned into an emntv section of the Starvhoard.
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You may want to link audio to slides when you have completed a chapter in your slideshow
with carefully synced audio. If you then add or delete slides before that chapter, the audio

[0

moves along with the slides and everything stays in sync.

In other cases, you may elect to not link the audio. This may be the case for background
(ambient) sound where exact synchronization is not needed, or while you are still working on
a chapter. Unlinked audio always stays in the same spot, regardless of how the slides above it

are being rearranged.

Locked Timing

When Locked Timing is enabled audio is paused when the slideshow is paused. Audio also jumps to the
appropriate position if the slideshow jumps back to the previous slide or skips ahead to the next slide.
In other words, with locked timing, audio always stays in sync with the visuals.

This is especially useful for those parts of the slideshow that have been carefully synced with
= the audio - e.g. for music that contains audio markers, or recorded narration.

It may not be appropriate for sound effects that merely provide an ambience for a slide.

Range

Set in and out points to restrict the portion of the audio to be played. This is done by dragging the
Range triangles inward. Only the light portion of the bar (between the triangles) will be played. The
audio file itself will not be modified, so all changes can be undone at any time. The audio waveform in
the Timeline adjusts automatically as you make changes.

For more precise control over in and out points, you can enter an exact in point or out point. From the
popup menu, select Finetune In Point or Finetune Out Point or double-click on the in point or out
point triangles to open a popover to enter an exact timecode or use the jog wheel.

In the Timeline, you can also press the Option key while clicking and dragging in the waveform to
set the in point. This is helpful when there is silence in the beginning of your audio and you want to
skip over the silence.

Volume

Controls how loud the audio is playing. Adjusting the volume is useful when different songs have been
recorded at different levels and do not playback with similar loudness. Click and drag the Volume
slider or enter a percentage in the text field.

You can also interactively adjust the volume directly in the Timeline. Click and drag the top of the
yellow line and drag up and down to increase or decrease the volume.

Ducking

When Ducking is enabled, the volume of other audio tracks is lowered by the specified percentage while
this audio item is playing. This may be useful to lower the volume of music, while a sound effect or
narration is playing. The default ducking factor is 50%, but you can enter a different percentage.

Specifying a ducking factor of 100% means that other audio tracks are completely muted
while this audio item is playing.

[0

Using a ducking factor around 70% is useful for narration. That way, music is lowered enough
so that the narrator can be heard clearly.

[0
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Fade-In and Fade-Out

Normally audio is automatically faded in at the beginning and faded out at the end. The duration of
these automatic fades is dependent on the visual transition between those slides. Please refer to the
table in the Transition Options section to find out how the choice of transitions affect the automatic
audio fades.

Audio fades can also be customized, if you turn off the Automatic checkbox. In this case the Offset
and Duration sliders will be enabled. Offset determines the start of a fade-in or fade-out (from the
beginning of a slide), while Duration determines the length of the fade itself.

¥ Fadein: || Automatic
Offset; = =——r——x (1,05 |
Duration: {;E

¥ Fadeout: [EI Automatic

Offset Cr——— (0,05
Duration: :r'.m !l,ljs

You can also set custom fade-ins or fade-outs by clicking and dragging in the Timeline.

= Drag the left edge of an audio item to adjust the fade-in offset.
= Drag the left yellow dot (on the volume curve) to the left or right to adjust the fade-in duration.

= Drag the right edge of an audio item to adjust the fade-out offset.

= Drag the right yellow dot (on the volume curve) to the left or right to adjust the fade-out duration.

Note that an audio item must be selected, or the yellow volume curve will not be visible.

| —

Some combinations of slide duration, fade offset, and fade duration are not possible. As you

| —

drag offset or duration, the other value may be adjusted automatically to make sure that only
valid combinations are used.
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'ﬁ' Title Options

The Title Options Inspector lets you change the attributes of selected titles in the Storyboard/Timeline.
You can make changes to multiple titles at once by selecting several titles in the Storyboard/Timeline,
and then making the desired modifications in the Title Options Inspector.

A title can have multiple fonts, styles, colors, paragraph alignments, etc. and span several lines of text.
You can modify text attributes using the standard Mac OS X font panel or the menu command available

in the menu.

To edit a title, double click it in the Stage. The title frame will switch from a thin frame to a thicker
frame with two resizing handles on the left and right edge. The text is already selected so you can
start typing. If you want to reflow the text, click on one of the handles to resize the width of the title's
frame.

¥ Title
omse [A0] EEEE]
Font Alignment
visibility: | | g3,
Animation: | _I _ﬂ,
Format

Click the font buttons to show/hide the Font panel and Color panel. Click on the alignment buttons to
change the alignment of the selected text. If a title is currently being edited (thick selection frame),
each paragraph in a title can have a different alignment. If a title is not currently being edited (thin
selection frame) the alignment is applied to the entire text of a title.

In the Font panel you can use advanced typographic features like shadows, ligatures, etc. The
Font panel also includes controls for changing kerning and leading. Click on the + or -
buttons to increase or decrease kerning or leading of the selected text. Press the Shift key
to go in 10x increments.

]

Select the title and click the Color button to display the Color panel. You can select colors or
you can create transparent titles by reducing the visibility in the Color panel. Please note that
this will affect the entire title. You cannot change the visibility of individual characters
separately.

[

In some cases it may be easier to prepare your text in TextEdit and save it as an RTF file,
= which is then imported into FotoMagico as a title.

Visibility

Use the Visibility controls if you don’t want a title layer to be visible during the whole duration of a
slide. Drag in the darker triangles (located on the outside) to restrict visibility to a certain range. Drag
the lighter triangles (located on the inside) (creating a ramp in the curve) to fade-in and fade-out the
title layer. The yellow sections in the bar represent the incoming and outgoing transition intervals.

The popup menu to the right contains several useful presets: Reset, Fade In, Fade Out, Fade
= In/Out.
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Animation

When animation is enabled in the Slide Options Inspector, you can use the Animation controls to fine
tune animation timing. The darker triangles (located on the outside) determine when an animations
begins and ends. The lighter triangles (located on the inside) adjust the fade-in and fade-out of the
animation. Refer to Fine Tuning Animation for more details.

74



FotoMagico 4 Help > Reference > Record Naration

ﬁ' Record Narration

In FotoMagico you can record audio directly to the Narration track. Select Insert >

Record Narration... from the [HIEESIEIE menu to reveal the Record Narration panel. First select the
desired workflow and input source (microphone). You may also want to adjust the input level of the
selected microphone.

= Workflow: Define new timing - Adjusts the duration of each slide as you speak. Whenever you
click on the Set Audio marker & Continue button, a new audio marker is added to the recorded
audio, the slide's continue type is changed to marker, and the slideshow advances to the next slide.

= Workflow: Keep existing timing - Does not modify the existing timing while you are recording
your narration. This is useful for slideshows that have already been carefully timed to music. Please
note that you may have to adapt the length of your narration to the existing slide durations to
make it fit. The Set Audio marker & Continue button will be disabled in this workflow.

= Source - Select the desired audio input source (microphone).
= Input Level - Adjust the input level to get a satisfactory recording.

= Playback - Keeping Mute Other Audio selected is useful to avoid feedback during recording, unless
you are using headphones for your audio output.

= Start/Stop Recording - Click on this button to start playback of the slideshow at the current
playhead position and record your narration. A new audio item will automatically appear in the
Narration track.
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ﬁ' Fine Tuning Animations

This section shows you how to fine tune animation (for images, movies and titles). First you need to
turn on animation with the Enabled checkbox in the Slide Options Inspector. The Stage displays the
currently selected slide twice - the start position on the left side, and the finish position on the right
side.

Click on a layer on the left side, then zoom, rotate, and drag it until the start position looks right to
you. Repeat the same for the finish position on the right side of the Stage. During playback the image
will be smoothly animated from the start to the finish position.

To preview the animation press the Spacebar key.

ik

Fine-tuning the Timing

The Animation controls in the Image Options, Movie Options, or Title Options provides fine tuning over
animation timing. Drag the triangles to set an initial delay, ease in, ease out, and final delay of the
animation. The small popup to the right provides a few presets to get you started: Linear, Ease In, Ease
Out, or Ease In/Out.

By default the image is animated at constant speed:

Animation: £,

A h

The bar represents the total time for which a slide is visible. The shaded yellow area on the left
represents the incoming transition, i.e. the length of time for which the transition from the previous
slide is still happening. The shaded yellow area on the right represents the outgoing transition or time
the transition to the next slide is going on. It is important to keep in mind that while a transition is in
progress, an image, movie, or title may only be partially visible. For this reason you may want to
restrict your animation to the white area, i.e. the period of time when no transition is occurring and an
image is completely visible. Let's look at an example to make this concept more obvious:

‘ Animation: ﬂ L, ‘

The screenshot above shows a scenario where animation starts right after the incoming transition has
ended. It then eases in, i.e. gradually picks up speed and proceeds at constant speed. After a while, it
eases out again and finishes right before the outgoing transition starts.

To control the exact timing of the animation, simply drag the triangles below the bar. The left outer
triangle controls the exact point in time when the animation begins. The inner triangles control easing
in and out, while the right outer triangle determines when the animation ends.

More Examples
Example 1:

These settings have the following effects: The slide will pause briefly at the start position before a
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slowly easing in the animation. Animation will continue at constant speed until the end of the slide
duration.

Animation: f £,
b

Example 2:

With this setting, the animation will start immediately. The motion will ease out towards the finish
position and briefly pause before advancing to the next slide.

Animation: —\.ﬁ £,
4 : b

Visibility

Use the Visibility controls if you don’t want an image, movie or title layer to be visible during the whole
duration of a slide. Drag in the dark triangles (outer triangles) to restrict visibility to a certain range.
Drag the lighter triangles (inner triangles) (creating a ramp in the curve) to fade-in and fade-out the
layer. The yellow section in the bar represent the incoming and outgoing transition intervals.

¥ Title

ronat [A] 0] [ETE[E]
Font Alignment

Visibility: ﬂ 2.
Animation: | ' ' | .

The example above has the following effect: Shortly after the slide has become completely visible, the
title will fade- in. It will stay visible for a while and then fade out before the transition to the next slide.

Please note the red area in the Animation bar represents the sections where a title is completely
invisible. You may want to restrict the animation to that part of the slide duration where the title is
visible. To achieve this, simply drag the darker triangles inward, so that animation doesn't overlap with
any red areas.
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